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1. Summary 
 
The Indian Ocean Global Ocean Observing System/Joint Technical Commission for 
Oceanography and Marine Meteorology (IOGOOS/JCOMM) “Western Indian Ocean 
Expendable BathyThermograph (XBT) Training Workshop” was successfully initiated 
and organized by the National Institute of Oceanography (NIO), Goa, India and the US 
NOAA’s Office of Climate Observation (OCO) during 4-7 October 2005 for capacity 
building for XBT observations in the western Indian Ocean. The participants of the 
IOGOOS/JCOMM Western Indian Ocean XBT Training Workshop arrived in Goa on 3rd 
and 4th October. The participants stayed at Hotel Marriott, Miramar, Goa from 4th to 7th 
October. In the evening of 4th October 2005 a get-together was arranged in the Hotel 
Marriott, with all the participants. Before the meeting, a registration desk was opened and 
all the participants registered themselves and collected a workshop kit containing the 
workshop agenda, NIO annual report, brochures, an NIO’s publication booklet on 
‘SAGAR’ and other regional tourist information brochures. A great deal of interaction was 
achieved among the participants including the Shipping and Customs officials from India. 
Dr. S.R. Shetye, Director, NIO was present at the meeting and interacted closely with the 
dignitaries and participants.  
 
A total of 50 participants including 15 foreign nationals and 35 Indians attended the 
workshop. The foreign nationals were from US (2), Australia (2), South Africa (2), Sri 
Lanka (1), Malaysia (1), Indonesia (1), Seychelles Islands (1), Mauritius (2), China (1), 
Nigeria (1) and Kenya (1). The Indian participants included the representatives from the 
government departments such as the Department of Science and Technology (DST) (1), 
Department of Ocean Development (DOD) (1), Directorate of Naval Oceanography and 
Meteorology (DNOM)(1), National Center for Antarctic Ocean Research (NCAOR) (3), 
Shipping Corporation of India (SCI)(3), Directorate of Customs and Central Excise, Goa 
(2), NIO (17), Research Scholars and Project Assistants from NIO (15). The names and 
addresses of the participants were provided in the Annexures 3 and 4.  
    
The Intergovernmental Oceanographic Commission (IOC), Paris supported the workshop 
with complete funding through its Regional Office in Perth, Australia. With the funding 
provided, the Shipboard Environmental (data) Acquisition System (SEAS) was procured 
for its demonstration at the workshop and its utilization on Western Indian Ocean XBT 
lines by the NIO personnel.  
 
On 5th October 2005, the workshop was inaugurated in a traditional way by Dr. V.S.N. 
Murty, Chair of the Workshop, Dr. Sidney Thurston, National Oceanic and Atmospheric 
Administration (NOAA) Office of Climate Observation (OCO), US, Dr. Gary Meyers, 
Chair, Climate Variability/Global Ocean Observing System’s (CLIVAR/GOOS) Indian 
Ocean Panel (IOP) for Climate, Australia and Mr. Steven K. Cook, Chair, NOAA Ship of 
Opportunity Implementation Panel (SOOPIP), US. Subsequent sessions were devoted to 
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the scientific results from the XBT temperature measurements in the Indian Ocean along 
various shipping routes, and the R&D activities of the foreign participants’ institutions. 
Presentations by the officials from the Shipping Corporation of India (SCI) and the 
Directorate of Customs and Central Excise, Goa, India focused on the shipping and 
customs procedures required for XBT measurements onboard merchant vessels steaming 
out of India. 
 
The second day, 6th October, was devoted to the demonstration of SEAS to technical staff, 
project members and research scholars for hands on experience and to the XBT data 
quality control measures. In the latter half of the day participants visited NIO and attended 
the seminar at NIO’s ‘Cardium’ by Dr. Gary Meyers on "The years of El Nino, La Nina 
and interactions with the tropical Indian Ocean". The NIO scientific staff, students and 
research scholars also attended the seminar. 
 
The concluding session of the workshop was held on 7th October, and a draft ‘Goa Plan of 
Action 2005’ was proposed and presented by Dr. Sidney Thurston.  This plan of action 
outlined specific milestones necessary to achieve the principal goal of the workshop which 
was to re-establish the western Indian Ocean XBT line IX-8 (Mumbai – Mauritius) 
recommended by the IOGOOS/CLIVAR Indian Ocean panel for Climate (IOP) and to 
present these observational results at the next IOC/WMO Ship Of Opportunity (SOOP) 
Meeting scheduled for approximately one year later in October, 2006. 
   
Necessary supplementary information was provided in a total of 10 Annexures at the end. 
The annexures included 1) the workshop announcement, 2) workshop agenda, 3) list of 
foreign participants, 4) list of participants from India, 5) welcome address by the 
Chairman, 6) Opening Remarks from Dr. Sidney Thurston, NOAA Office of Climate 
Observation, 7) list of participants attended the SEAS demonstration, 8) the abstract of 
seminar by Dr. Gary Meyers, 9) the proposed draft ‘Goa Plan of Action 2005’ by Dr. 
Sidney Thurston and 10) SEAS Training Manual by Mr. Steven K. Cook. 
 
2. Acknowledgements 
 
The Chairman, the organizing committee members and the colleagues were thankful to 
Dr. S. R. Shetye, Director, NIO for his keen interest in hosting the workshop in Goa.  
They expressed their gratitude to the UNESCO’s Intergovernmental Oceanographic 
Commission (IOC) for providing necessary funds to procure the SEAS unit and to meet 
the workshop logistics. The workshop was conducted under the regional bodies such as 
the Indian Ocean Global Ocean Observing System (IOGOOS) and the Joint Technical 
Commission for Oceanography and Marine Meteorology (JCOMM). Dr. Sidney Thurston, 
NOAA’s OCO, Ms. Candyce Clark, IOC, Paris and Dr. William Erb, Director of the IOC 
Perth Regional Office, Australia coordinated well with the Chairman for the timely arrival 
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of funds to NIO. We were thankful to the participants from India and abroad for their 
participation and keen involvement in the proceedings of the workshop.     
 
We were profusely thankful to the participation of officials from the Shipping Corporation 
of India (SCI), Mumbai and Chennai and the officials from the Directorate of Customs 
and Central Excise, Goa for their overwhelming interest and support for the XBT 
measurements onboard their merchant vessels. It is the hope of the participants that these 
Government of India Officials will continue to work closely with the scientific community 
for the fruitful observations of the Indian Ocean.  
  
We are also thankful to the NIO purchase department personnel, Mr. Johnny Mascarnhas 
and his team, and Mr. Rommel Coelho and Mr. Jim Hannon, M/s Lockheed Sippicon Ltd., 
USA and the transportation agents M/s Mid-America in US and M/s Jeena & Co., in Goa 
for their fullest cooperation in the procurement and timely delivery of the SEAS unit to 
NIO for the successful demonstration and training. We thank Mr. Cook for assembling, 
configuring and testing the SEAS unit prior to shipment to NIO. 
 
The Chairman of the workshop was thankful to his colleagues, Dr. S. Prasanna Kumar, Dr. 
Y.K. Somayajulu, Dr. V.V. Gopalakrishna, Dr. P.N. Muraleedharan, Mr. M.S.S. Sarma, 
Mr. Dasmond Gracias, Mr. Areef Sardar, Mr. C.M. Dias, Mr. Chitari, Mr. Shiek, Mr. R.L. 
Chavan for their cooperation and help rendered at various stages for the smooth 
organization of the workshop. Dr. Muralidharan and Mr. Gracias took excellent care of 
arranging lunch, dinner, boat cruises etc. The chairman was also thankful to Ms. Geeta 
Madasami and Ms. Leena Shirgaonkar for their finest secretarial assistance. Special thanks 
were due to Mr. Sanjay, the travel agent for arranging the Pre-Travel Advice to the foreign 
participants. The Chairman expressed his thanks to the Hotel Marriott management and 
the Hotel personnel, Mr. Pratyush Anand, for the excellent amenities provided for 
organizing the workshop. 
 
3. Presentations at the Inaugural session   
  
At the start of the formal invocation of the workshop, Dr. Prasanna Kumar, Deputy 
Director, NIO invited Dr. V.S.N. Murty, Chairman of the workshop, Dr. Sidney Thurston, 
Manager, Office of Climate Observation (OCO), NOAA, US, Dr. Gary Meyers, CSIRO, 
Hobart and Chairman, CLIVAR/GOOS Indian Ocean Panel for Climate, Mr. Steven K. 
Cook, Chairman, SOOPIP, NOAA, US to occupy the seats on the dais. This was followed 
by the floral presentations by young ladies. Dr. Murty gave the welcome address and 
invited participants of the “IOGOOS/JCOMM Western Indian Ocean Expendable 
Bathythermograph (XBT) Training Workshop” to Goa and to The Hotel Marriott, 
Miramar, Goa. The national invitees included the representatives of the Indian 
Organizations such as the NIO, National Center for Atmospheric and Oceanic Research 
(NCAOR), Department of Science and Technology (DST), Department of Ocean 
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Development (DOD), Directorate of Naval Oceanography and Meteorology (DNOM), 
Shipping Corporation of India (SCI), Directorate of Customs and Central Excise, Goa. 
The international participants were from US, Australia, South Africa, Malaysia, Indonesia, 
Sri Lanka, Seychelles Islands, Mauritius, Nigeria, Kenya and China. The Annexures 1 and 
2 provide the necessary information on workshop announcement and the workshop 
agenda. 

 
Dr. Sidney Thurston presented an overview of the workshop and the text of his 
presentation is given in Annexure 6. Dr. Thurston briefed  a few of the ongoing and 
emerging partnerships in this part of the world between NOAA and regional Colleagues 
such as India, China, Indonesia and Japan. NOAA’s Office of Climate Observation, the 
United Nations Framework Convention for Climate Change (UNFCCC), the Global Earth 
Observing System of Systems (GEOSS), WMO/IOC JCOMM Objectives & Priorities are 
now aligned and documented in the October 2004 Global Climate Observing System 
(GCOS) GCOS-92 Report. He informed the participants that the first GOOS milestone of 
1,250 surface drifters deployed globally was achieved in September 2005 in Halifax Nova 
Scotia.  A total of 4081 platforms are maintained globally and the U.S. supports 2315, of 
which the NOAA Office of Climate Observation supports 2148. With the Indian Ocean 
influencing the monsoons and climate variability in the region as well as possibly playing 
a role in the western United States precipitation patterns on decadal time scales, as well as 
the interaction between the Indian Ocean and Pacific Ocean via the Indonesian 
Throughflow and possible connection with El Nino, NOAA has been deploying drifting 
buoys, XBTs, Argo floats and tide gauges into the Indian Ocean region for years. At this 
stage, Dr. Thurston recalled the recent collaborative efforts between NIO, DOD and 
NOAA’s Pacific Marine Environmental Laboratory  (PMEL) for the deployment of 4 
Atlas surface moorings and 1 sub-surface Acoustic Doppler Current Profiler (ADCP) 
mooring in the equatorial Indian Ocean from the Indian research vessel, the ORV Sagar 
Kanya. He has further expectations that this collaboration would continue and expand with 
Indian (NIO, NIOT, DOD/NCAOR, etc) and other regional institutions. 
 
With regard to XBT measurements, Dr. Thurston pointed out the evolution from 
Broadcast XBT to High Density XBT Lines (HDX)/Frequently Repeated XBT Lines 
(FRX) mode as Argo comes online. Focusing now on the goal of this workshop and 
pointing out the global map of XBT lines, the western Indian Ocean is currently under 
sampled and the objective of this workshop is to remedy this revitalizing the dormant IX-8 
XBT line and other high-priority XBT lines as determined by the IOGOOS/CLIVAR 
Indian Ocean Panel.   
 
In conclusion, Dr. Thurston mentioned that NOAA had undertaken a major initiative to 
implement increased global ocean observations for GEOSS, and the UNFCCC via the 
GCOS Implementation Plan (GCOS-92), to include the Indian Ocean, and was looking 
forward to working closely with regional Institutes and other regional partners to provide 
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the needed global coverage for not only climate applications but other marine services and 
extreme events such as weather prediction, global and coastal ocean prediction, marine 
hazards warning, transportation, marine environment and ecosystem monitoring. Dr. 
Thurston concluded by thanking his audience and noting that there are many opportunities 
for fruitful Indian Ocean partnerships, NOAA seeks to engage with regional colleagues 
and we look forward to building this system together. 
 
Following Dr. Thurston’s presentation, Dr. Gary Meyers presented briefly on ‘the XBT 
Network-an element of the sustained observing system in the Indian Ocean’. Dr. Meyers 
started with the brief description of XBT and its different components, and the purpose of 
using of merchant ships for XBT observations was mainly due to the fact that these ships 
would cover nearly exactly repeated routes for long term measurements, cost effective of 
measurements, availability of volunteer observers, technical expertise and sea going 
people. The Indian Ocean Science Drivers are towards improved description, 
understanding and ability to predict seasonal monsoon, break-periods and ocean-
interaction, Monsoon  ENSO Monsoon  Indian Ocean Dipole interactions and 
decadal variability and warming trends. Dr. Meyers further narrated the sustained, 
integrated Observing System (OS) consisting of XBT lines, Argo floats, surface drifters, 
biological sensors and Boundary arrays. He distinguished the need of XBT measurements 
from that of growing Argo floats deployment, the former serves the need to observe 
relatively small scale (50-100 km) features (e.g. boundary currents, upwelling zones, 
thermocline ridges and domes.), while Argo program caters the purpose of observing 
variations of basin-scale (>1000 km), decadal variation (e.g. change in subtropical gyre 
circulation.) 
 
After Dr. Gary Meyer’s presentation, the Chairman led the dignitaries on the dais to the 
traditional lamp to illuminate it. Then the Chairman declared the workshop was open for 
the sessions, scientific presentations and discussions, as per the workshop agenda 
(Annexure 2).  
 
The inaugural function ended with a vote of thanks by Dr. Y. K. Somayajulu, Scientist, 
NIO, Goa. 
 
Following the inauguration, Dr. P. Sanjeeva Rao, Representing the DST, presented the 
XBT observations in India – their origin, growth and sustainability as a major Ocean 
Observing System (OOS) in the Indian Ocean. The Indian TOGA (Tropical Oceans 
Global Atmosphere) was India’s response from DST with full funding support for regular 
monitoring of the thermal structure along specified XBT lines in the Seas around Indian 
region:  
-  Chennai (Madras) – Port Blair in the Bay of Bengal (First sampling during mid 1990. 

About 2450 XBT profiles and 300 surface salinity samples were collected and analyzed) 
-  Port Blair-Kolkata in the Bay of Bengal (sampled at 3-monthly interval since 1991. 
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About 1450 XBT profiles and 250 surface salinity samples were collected and analyzed). 
-  Mumbai (Bombay) - Mauritius in the western Indian Ocean (First XBT survey was 

undertaken during February 1992, at an interval of 4-months. About 500 XBT profiles 
and about 100 salinity samples were collected and analyzed) 

- Chennai (Madras) - Singapore in the Bay of Bengal (Observations along this line 
commenced during early 1995, sampled at 3-monthly intervals. About 500 XBT profiles 
and 250 salinity samples were obtained and analyzed) 

 
XBT observational data was extensively used in understanding the ocean processes, the 
development/validation of various ocean models and also validated some of these models 
for studying the circulation features in the north Indian Ocean. Ships of opportunity were 
utilized to systematize the monitoring of upper ocean thermal structure using XBTs along 
the specified lines at 50 km interval close to the coast and 100 km in the open ocean. XBT 
observations also formed an important component of the Indian Climate Research 
Program’s (ICRP) ocean-atmosphere field campaigns such as Bay of Bengal Monsoon 
Experiment (BOBMEX) and Arabian Sea Monsoon Experiment (ARMEX). Since 1997-
98, the Integrated Indian Ocean Observing System (IIOOS) was evolved in India with the 
funding support from the Department of Ocean Development (DOD), with sustained XBT 
measurements as one of the observing system.   About 300 XBT profiles were collected in 
the southern Ocean.  
 
Dr. K. Somasundar, representing the DOD, presented a detailed account on the Ocean 
Observing System (OOS) in the northern Indian Ocean. Dr. Somasundar described the 
rationale for the observational network, covered wide variety of platforms that were in use 
and maintained by DOD in the Indian Ocean region. He also described the observational 
programs that were related to the national level and also international collaborations with 
the Indian institutions. The evolution of observational programs, their applications and 
utility of ocean data thus generated, the dissemination and exchange of information 
gathered through Global Telemetry System (GTS), Inmarsat/Argos in real time and Ocean 
portal for delayed mode data transfer, cost benefits of the observational network etc, were 
shown through a number of slides. Dr. Somasundar also presented some interesting results 
from the Argo data and moored buoy data, particularly with reference to extreme events 
such as cyclones. The various data products generated from the Argo program were also 
mentioned. 
 
Mr. Steven Cook started his inaugural address with the broad JCOMM structure wherein 
SOOPIP is an activity related to oceans, and mentioned the Current SOOPIP Participants. 
The broader goals of SOOPIP are to 1) review, recommend on and, as necessary, 
coordinate the implementation of specialized shipboard instrumentation and observing 
practices dedicated to temperature and salinity measurements, 2) coordinate the exchange 
of technical information on relevant oceanographic equipment and expendables, 
development, functionality, reliability and accuracy, and survey new developments in 
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instrumentation technology and recommended practices, 3) ensure the distribution of 
available programme resources to ships to meet the agreed sampling strategy in the most 
efficient way, 4) ensure the transmission of data in real time from participating ships; 
ensure that delayed mode data are checked and distributed in a timely manner to data 
processing centres, 5) maintain, through the SOOP Coordinator, appropriate inventories, 
monitoring reports and analyses, performance indicators and information exchange 
facilities, 6) provide guidance to the coordinator in his support for the SOOP, 7) prepare 
annually a report on the status of SOOP operations, data availability and data quality. 
 
Dr. Steven Cook put forward the future Plans of SOOPIP as 1) XBT Recorder 
intercomparison experiment – summer 2005, 2) NOAA (Hand & Auto-launcher), 3) 
CSIRO (Devil System), 4) SIO (Autolauncher), 5) Sippican (Hand launcher). The science 
drivers for the support of specific XBT Lines were based on the recommendations from 
“The Upper Ocean Thermal Network” paper published in the document “Observing the 
Oceans in the 21st. Century published in 2001. This document describes the scientific 
requirements and support needed on certain specific lines for  

• ENSO Prediction. 
• Tropical Ocean Variability and Prediction. 
• Global and Regional Heat Storage. 
• Transport and Circulation. 
• Mid-high Latitude Variability. 
• Ocean State Estimation and Model Testing. 
• Climate Change. 

 
Mr. Steven Cook further elaborated the issues concerning the Indian Ocean for XBT 
observations. 

• Line support “Ownership” 
• Logistical problems 
• Shipping Companies and Agents 
• Customs delays 
• Shared expenses 

 
What can SOOPIP do? 

• NOAA has provided a pool of probes that can be used to partially support these 
lines. 

• What can the SOOPIP community do to increase or initiated sampling along those 
lines that are presently being under sampled or not sampled at all? 

 
Dr. Regina Folorunsho, Member of JCOMM Management Committee, Nigeria presented 
the JCOMM initiatives for the XBT observations in a detailed way starting with function 
of JCOMM, its global organization, its concerned program areas, XBT activities. The 
JCOMM, Joint Technical Commission for Oceanography and Marine Meteorology, is one 
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of the activities of the World Meteorological Organization/Intergovernmental 
Oceanographic Commission (WMO)/(IOC). The JCOMM provides international, 
intergovernmental coordination, regulation and management mechanism for operational 
oceanography and marine meteorological observations, data management and services 
system. One of the activities of global organization of JCOMM is its major focus on 
capacity building and implementation assistance for services.   
 
JCOMM’s Ships-of-Opportunity Programme (SOOP) is the most relevant to the present 
workshop. This SOOP has its primary goal to fulfill upper ocean data requirements from 
ships of opportunity (SOO). Its data management is taken care of through the Global 
Temperature Salinity Profile Programme (GTSPP). The other types of measurements 
include pCO2, phytoplankton concentration and collection of data using 
Thermosalinograph (TSG), Expendable Conductivity-Temperature-Depth probe (XCTD), 
Conductivity-Temperature-Depth probe (CTD), Acoustic Doppler Current Profiler 
(ADCP). JCOMM supports many other operational needs (e.g. fisheries, shipping, 
defense, etc.) through the provision of upper ocean data for data assimilation in models 
and for various other ocean analysis schemes.  
  
JCOMM also puts in efforts to convince governments to provide funding to meet global 
implementation plan/targets and to the establishment of common fund (Trust Fund) for 
consumables. Dr. Regina showed a slide displaying the present XBT lines of High Density 
Lines (HDX), Frequently Repeated Lines (FRX) and Low Density Lines (LDX). As of 
December 2004, the number of sub-surface temperature profiles distributed via GTS from 
the global ocean under SOOP reached 18,253 from 1602 stations.  Out of this number of 
profiles, the XBT temperature profiles distributed via GTS formed only 2061 from 40 
platforms.  
 
In conclusion, Dr. Regina intimated the participants that JCOMM considers XBT data as 
an important aspect to understanding global met-ocean   processes and climate change and 
its activity has and will also address several important scientific goals, both for GOOS, 
CLIVAR and other MET- OCEAN programme, and the determination of JCOMM to 
support the XBT program. 
 
4. Scientific presentations on the regional XBT programs   
 
Dr. Gary Meyers in his address presented the scientific results along the IX01 (Perth – 
Java) and IX12 (Perth – Red Sea) XBT lines in the Indian Ocean, with which data he  and 
his colleagues extensively worked. He discussed on two areas of research – the Indonesian 
Throughflow (IT) and Indian Ocean Dipole (IOD), their role, importance and variability. 
The IT transports warm water into the Indian Ocean near the equator and exits at the south 
end 10°C cooler. The heat gained by the equatorial Pacific is released to the atmosphere in 
the Indian sector. The 14 year long time series XBT data along IX01 gave a total transport 

 10

http://www.nodc.noaa.gov/GTSPP/gtspp-home.html


of 9.1x106 m3/s with a transport weighted temperature of 19.7°C and salinity of 35.05. The 
corresponding values along PX2 (Singapore – Darwin) section are 8.8x106 m3/s, 18.1°C 
and 35.2. On the Indian Ocean SST dipole and wind, Dr. Meyers pointed out that since 
1999 it was learnt that subsurface ocean dynamics plays a role in IOD, (upwelling, Rossby 
and Kelvin waves), and leads to a hypothesis on the mechanism of IOD growth. In 
general, XBT lines provide subsurface profiles through the most energetic areas and 
subsurface profiles are required for surface heat budget. The XBT lines IX01 and IX12 
cross the cores of the major current systems – the South Equatorial Current (SEC), South 
Equatorial Counter Current (SECC) and Indonesian Throughflow (IT) and the zones of 
deeper thermocline in the Indian Ocean. Dr. Meyers also pointed out that the interannual 
standard deviation of temperature along these XBT lines was high in the depth range of 50 
– 150 m. It was 2° C off Java coast and it was between 1.5° and 1.75° C in the central 
Indian Ocean.  His examination of ocean-response to remote wind forcing highlighted the 
Pacific winds response on the Indonesian Throughflow and that of equatorial winds on the 
Java coastal upwelling region.   
 
Dr. Lisa Cowen, Marine Operations Group, Australian Bureau of Meteorology, presented 
a detailed account on the Australian XBT SOOP which has its goals to sample the XBT 
lines according to the requirements determined by expert panels for GCOS/GOOS and 
complemented by national requirements, to provide timely and high quality upper-ocean 
thermal (UOT) data to support oceanographic research, climate analysis and research, 
defense and fisheries, and to meet agreed national and international obligations, and 
advance national interests in, and through the exchange of physical oceanographic data. 
 
Dr Cowen described the status of the Australian XBT SOOP, including the real-time XBT 
data transmission. The data were sent via Argos and processed by CLS Argos.  The 
number of transects covered and number of XBT profiles collected along the Frequently 
Repeated XBT lines (IX01), high density XBT lines (IX28, PX30, PX34) and Low density 
XBT lines (IX22, PX02) were also presented. Dr. Lisa also mentioned that both the 
Bureau of Meteorology and CSIRO would change to the latest software developed at 
CSIRO, called the Devil XBT system, in the coming years. 
  
Dr. V.V. Gopalakrishna presented the XBT Observations in the Lakshadweep Sea. He 
began the presentation with the XBT lines being managed by NIO since 1992 with the 
funding from DST, New Delhi and subsequently by DOD, New Delhi. Dr. Gopalakrishna 
emphasized the recent progress of XBT observations for the national Indian Climate 
Research Program (ICRP), which Dr. Sanjeeva Rao described in his inaugural 
presentation. The XBT observations in the Lakshadweep Sea was part of the ICRP, 
wherein the sea surface salinity samples were also being collected regularly to understand 
the evolution of warm pool of the Laskhadweep Sea (Southeastern Arabian Sea). These 
specially designed XBT observations began from May 2002, and so far 668 XBT profiles 
and 1147 surface salinity samples were collected and analyzed. Dr. Gopalakrishna 
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emphasized the need of surface salinity samples and the important feature of subsurface 
temperature inversions in the Lakshadweep Sea during winter months. He described the 
evolution of surface circulation and westward propagation of temperature inversions in the 
study area. The remarkable drop in the sea surface salinity was reported between 1.7 and 
3.4 during the winters of 2002, 2003 and 2004 and Dr. Gopalakrishna then discussed the 
associated dynamics and possible mechanisms for this observed surface salinity variation.  
One possible mechanism proposed was the large intrusion of more fresh water into 
Lakshadweep Sea during winter followed by a good monsoon.  
 
Dr. Murty presented briefly the scientific results documented from the XBT observations 
along IX-08 (Mumbai – Mauritius) Shipping route carried out during 1992-1999.  He 
highlighted the presence of the thermal front, as identified by the dome like structure, 
between 3°S and 8°S in the western Indian Ocean throughout the year. In some years, the 
front shifted equatorward during ENSO events. The westward volume transport associated 
with the South Equatorial Current (SEC) increased as a contribution of Indonesian 
Throughflow during the ENSO events.  He opined further sustained XBT observations 
only would reveal the impact of ENSO on the western Indian Ocean thermal structure and 
the volume transport variability of SEC.   
 
5. Presentations by the officials from Shipping Corporation of India and Customs 
    and Central Excise 
 
Capt. Praveen Kumar, the official representative from the Shipping Corporation of 
India, Mumbai, presented on the ‘Shipping procedures and clearances required onboard 
Merchant ships’. He described the various rules that are in force now and necessary 
procedures that should be followed for boarding the vessels for XBT observations. Capt. 
Kumar also provided a variety of hand-outs for all for the easy access to various proforma. 
He informed that the current Merchant Shipping Act (MSA) 1958 was the Governing 
instrument for regulation of merchant shipping in India. Under Section 100 of the MSA 
1958 the Article Agreement was a legal document specifying the rights and duties of all 
persons engaged on board. The DG Shipping of India with its Order No. 7 of 2002 and of 
3rd December 2002 revised the form for articles of Agreement and procedure for signing 
on, off etc. He stated that the revised procedures were in tune with international practices, 
catering to quick turn around of the vessels.  
 
Signing on the Articles of Agreement (Details are as per Order no 7 of DGS) required  
1.Valid Continuous Discharge Certificate. 
2. Valid Passport (Ideally with six months validity). 
 
The participants should have undergone basic courses prescribed in STCW 95 namely 
1. Personal Survival Techniques. 
2. Elementary First Aid. 
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3.Basic Fire Fighting  
4. Personal safety and Social Responsibility. 
 
He stressed that for all seafarers the medical fitness standards were very stringent and 
internationally applicable. Any person joining a Merchant vessel had to be medically fit as 
a minimum requirement (Copy of the medical examination format was given as hand out). 
He further stated that under section 456 Central Government of India was empowered to 
exempt or relax the application of the rules (Copy of the relevant section was given as 
hand out). The importance of risk and liability issues need to be addressed adequately 
prior to joining the vessel were highlighted. In the case of any eventuality involving 
diversions the stakes involved might be of very high financial value that had to be covered 
and provided for by the employers or the institutions. Capt. Kumar added that Individual 
Indemnity Bonds were not adequate for the risk and liabilities involved while sailing on 
merchant vessels (SAMPLE INDEMNITY BOND was given as hand out).  
 
Following Capt. Kumar’s presentation, Mr. Mukund Shinde presented the Indian customs 
procedures for handling and clearance of scientific equipment including the XBT probes.  
 
6. Presentations on the R & D activities of participants’ institutions     
 
The session on the presentations continued after the lunch. At this session, the participants 
mostly presented the research activities at their respective institutes. However, they were 
open to collaborate with the international groups for the XBT and other ocean 
measurements.   
 
Prof. Chris Reason, Dept of Oceanography, University of Cape Town, South Africa, 
presented South African research interests in the western Indian Ocean. He discussed 
collaborations of the University of Cape Town with NIOZ, KNMI & Utrecht concerning 
current meter moorings and XBT deployments in the SW Indian Ocean and with NOAA 
with regard to XBTs deployment in the Atlantic. The collaborative projects with the Dutch 
institutions are likely to be completed by 2007 whereas with that with NOAA is ongoing. 
In addition, as part of the Coelacanth project funded by the South African government, 
there are XBT and Argo float deployment opportunities from the RV Algoa in the 
Mozambique Channel, Comores and Kenyan regions in austral winter 2006-2008.He also 
pointed out that the potential SOPs were along Maersk Durban – Mauritius – Singapore 
and Durban – Mauritius – Fremantle Safmarine Durban – Comores; Durban – Mauritius; 
Durban – Madagascar; Durban – Dubai.  
 
He also discussed the correlations between the Indian Ocean SST and Southern African 
rainfall with valuable illustrations. The necessity of seasonal forecast information relating 
to dry and wet spell occurrence, onset and end date of main rainy seasons to the farmers 
and other users was highlighted. His main conclusion was that designing an observing 
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system that monitors both tropical and mid-latitude South Indian Ocean areas (including 
XBTs) necessary to improve southern and East African climate prediction. 
 
Dr. Mitrasen Bhikhajee, Director of Mauritius Oceanographic Institution (MOI) 
presented the various projects undertaken by the Institute, from the year of its 
establishment since January 2000. The policy statement of the MOI is to embark on 
scientific research in understanding the oceanic processes and facilitate harnessing 
resources for Mauritius from its legal maritime zones. Since this institute is established 
very recently, it has no established XBT observational program, however, the institute has 
already been involved in various national interest projects and some of them with 
international collaborations. Dr. Mitrasen asserts that his developing institute is open to 
collaborative research with the international organizations/institutes. Since many of the 
XBT lines in the southern Indian Ocean end at Mauritius, it is envisaged that there would 
be growing interest to enter into collaborations with the MOI in the coming years and as a 
developing Institute the MOI could cater the requirements.  
 
Dr. Charles Magori, Dr. Rita, Mr. Xiang, Dr. Arulananthan, Mr. Roland Azemia, Mr. 
Ashok Paul made brief oral presentations about their activities in their respective 
institutes.   
 
7. Demonstration of Shipboard Environmental (Data) Acquisition System (SEAS) by 
    Mr. Steven K. Cook 
 
The first half of the second day of the workshop was devoted to the SEAS demonstration 
and XBT data quality control (QC). Mr. Steven Cook gave a presentation on the SEAS 
and AMVER/SEAS 2000 to the participants at the Hotel Marriott. The actual 
demonstration of SEAS for hand on experience was conducted at NIO in the afternoon. 
There were 15 researchers and technical persons who specially attended the SEAS 
presentation lecture and demonstration. Mr. Steven Cook introduced the Automated 
Merchant VEssel Reporting program (AMVER)/Shipboard Environmental data 
Acquisition System (SEAS) 2000, its set up, operation, transmission and archive of the 
XBT data in a detailed way.  The AMVER/SEAS 2000 was the improved version as it was 
based system to Windows, and provides a method for the “real-time” transmission of 
meteorological, oceanographic and AMVER messages from vessels at sea. This 
AMVER/SEAS could be used for: 

• Synoptic Weather Observations. 
• LDX & FSX Medium VOS handlaunch XBT's. 
• AutoIMET – hourly transmissions. 
• High Density XBT’s using Auto Launchers. 
• Other observations. 
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The procedures for the installation of the AMVER SEAS Software and hardware as well 
as other related issues were demonstrated to the participants.  Mr. Cook also briefed the 
participants on the quality control procedures for SEAS data.      
 
8. XBT data quality control procedures 
 
Dr. Lisa Cowen presented the XBT data quality control techniques being practiced by 
CSIRO and Bureau of Meteorology. Dr. Cowen gave many examples of how XBT profile 
could be wrong and needed quality control, and the measures to be taken to improve such 
XBT profile. She answered a series of questions by the participants. 
 
9. NIO visit and seminar by Dr. Gary Meyers in ‘Cardium’ at NIO 
 
Though the workshop was devoted to the XBT measurements, Dr. Prabhu Desai and Dr. 
Antony Joseph, scientists from NIO wanted to share their latest research on the utility of 
cellular modem for real time data acquisition and transmission of sea level data from the 
tide gauges via internet, with the visiting participants from the developed and developing 
Indian Ocean rim countries.  Dr. Antony made a brief presentation of his work at the NIO 
Cardium prior to the beginning of seminar by Dr. Gary Meyers.  During his presentation, 
Dr. Antony discussed the merits of this net working system over the existing tide gauges 
along the coast and its major applications, particularly serving as an ‘Alert and Warning in 
the event of oceanogenic natural disasters. The present system provides the much needed 
capability for alert and warning in the event of oceanogenic disasters such as storm surges 
and tsunamis. Dr. Antony replied to some of the questions from participants.  

Dr. Gary Meyers presented his seminar on his latest research work on the tropical Indian 
Ocean "The years of El Nino, La Nina and interactions with the tropical Indian Ocean".  
While elaborating his review on the Indian Ocean Zonal Dipole and its dependent/ 
independent linkage to the of El Nino Southern Oscillation (ENSO), he proposed a 
method that identified when the positive or negative extrema of ENSO and Indian Ocean 
Dipole occurred, and used this method to classify each year from 1876 to 1999. The 
method was statistical in nature, but appeared to be a strong basis on the oceanic physical 
mechanisms that control variability of the near equatorial Indo-Pacific basin. He and his 
co-authors tested the sensitivity of the classification of years by calculating composite-
maps of Indo-Pacific SST anomaly and probability of below median Australian rainfall for 
different categories of the El Nino-Dipole relationship. Finally, Dr. Gary Meyers pointed 
out that in order to describe, understand and predict ENSO and the dipole in the Indian 
Ocean, the CLIVAR/GOOS Indian Ocean Panel had prepared an implementation plan for 
sustained, basin-scale ocean observations that included the sustainable XBT 
measurements along many shipping routes in the Indian Ocean. 
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10. Concluding session and proposal of the ‘Goa Plan of Action 2005’ by Dr. Sidney 
Thurston. 
 
The workshop concluding session began at the Marriott Hotel at 0900 hrs on 7 October. 
All members were asked to express themselves on the workshop proceedings and their 
suggestions. Starting the discussion, Dr. Sidney Thurston presented a draft ”Goa Plan of 
Action 2005” and is given in Annexure 9. Dr. Thurston emphasized the requirement of 
24000 XBTs in a year for a perfect deployment in the global oceans.  As per the Goa Plan 
of Action 2005, plan, the organization of ‘Western Indian Ocean XBT Training 
Workshop, Goa, India’ and the shipment of SEAS equipment from IOC to NIO, to help 
revitalize IX-8 in the Western Indian Ocean, were completed. NOAA also proposed a 
series of additional milestones outlined in the “Goa Plan of Action 2005” with regard to 
the commencement of XBT observations along the Mumbai – Mauritius shipping route 
(IX-8) including supporting the Inmarsat Communications Costs for data transmission 
when SEAS was put to use, and shipping of 5 cases XBTs to NIO to support 50% of the 
XBTs for IX-8. 

 
The future proposals of NOAA with regard to enhancement of the XBT observations in 
the Indian Ocean were presented in the “Goa Plan of Action 2005” and include the 
planned ‘Eastern Indian Ocean Capacity Building Workshop’, “Use of Ocean 
Observations to Enhance Sustainable Development”, Bali in early 2006, and a proposed 
follow-up on the ‘Western Indian Ocean Training and Capacity Building Workshop in 
Mauritius in June 2006’, and the SOOPIP Meeting at SOT-4, where the results of the 
revitalized IX-8 line will be presented along with other Indian Ocean XBT Lines in 
October 2006. 
 
Some members expressed that the future workshops should cover a session on the XBT 
data analysis and techniques for the members who were not familiar with XBT 
measurements and their utility. The Chairman and the members felt that it was an 
important suggestion. Ms. Regina Folorunsho, the member of JCOMM from Nigeria 
suggested a 3-tier XBT training involving the use of SEAS software, Quality Control 
(QC) of XBT data and Data analysis techniques and further expressed her opinion that the 
advanced countries such as Australia, India and China should come forward to share their 
capabilities and facilities with the less developed nations of the Indian Ocean in ocean 
based research. 
 
South African participants showed interest in maintaining the designated XBT lines in the 
tropical and southern Indian Ocean, and offered to help in looking for international 
funding support. 
 
It was important to note that the participating members from South Africa, Sri Lanka, 
Mauritius and Kenya expressed their interest to establish collaborations with the NIO for 
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carrying out joint research and ocean observations, particularly XBT and others, in the 
Indian Ocean. This workshop was therefore quite successful in bringing together the 
participants from the Indian Ocean rim countries  
 
11. Outcome/Recommendations from the workshop 
 
After all the members expressed their suggestions, the Chairman replied to the proposal of 
the ‘Goa Plan of Action 2005’. The Chairman appreciated the activities proposed for the 
action plan. The activities 1 and 2 were already completed. He, however, expressed 
immediate concern for the activities from 3 to 6. He informed the members that at present 
the XBT observational program along IX-8 (Mumbai – Mauritius) was discontinued for 
want of ships from Mumbai to Mauritius and the non-availability of funds. Resumption of 
XBT observations along IX-8 would have to be looked into afresh. The Chairman felt that 
one of the outcomes of this workshop is to put forward the recommendation by the 
members to the resumption of IX-8 XBT line for the sustainable XBT observations along 
this line that helps cover the equatorial and western Indian Ocean in the context of Indian 
Ocean climate and monsoon variability research.  This recommendation would have to be 
intimated through the Director, NIO to the national funding agencies – the Department of 
Science and Technology (DST) and the Department of Ocean Development (DOD), along 
with a science plan in the form of a formal proposal. In general, the scientific proposal 
requests for 1) funding support for procurement of XBTs, 2) to cover travel costs for 
technical/scientific personnel to board the merchant vessels at the port of embarkation and 
return to the institute from the port of disembarkation and 3) the service costs towards the 
real time data transmission on the use of SEAS via GTS or inmarsat or internet etc. From 
the Shipping Corporation of India (SCI) participants, it was learnt that the most important 
issue appeared to be the resumption of ships along the IX-8 shipping route for a longer 
period either by the Shipping Corporation of India or other private liners, before 
submitting the scientific proposal to the appropriate national funding agency. The 
Chairman intimated that the personnel involved in the XBT measurements at NIO would 
have to do their best to liaison with the shipping companies (as that was done in the past), 
when there was information of resumption of ships along IX-8 for a longer period. The 
NIO personnel would also have to interact with the funding agencies with the timely 
submission of a project proposal on a long-term basis. Therefore, fixing of specific time 
frame for XBT measurements along IX-8 is entirely dependent upon the availability ships 
and the availability of full funding support to meet all the logistics from the national 
agencies. It is anticipated that progress in this area will be made after knowing from SCI 
about the availability of ships along IX-8 for scientific observations. This is expected to 
occur when NIO and SCI meet in December 2005, per the “Goa Plan Of Action 2005” 
milestone to successfully achieve the goals of this workshop. 
 
Meanwhile, the participating member from Kenya pointed out about the availability of a 
regular cargo ship from Mombasa port to Mauritius port. This member and the Director of 
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Mauritius Institute of Oceanography (MIO) also expressed their interests to take up the 
XBT measurements along this shipping route in the western Indian Ocean. While there are 
a lot of other measures to be considered on this shipping route, the Chairman expressed 
that this was an excellent idea of considering this shipping route for sustainable XBT 
measurements in the western Indian Ocean. This matter could be taken up at the 
appropriate level by Dr. Gary Meyers, the Chairman, IOP for discussion with the IOP 
members, for the science plan of IOGOOS/CLIVAR. 
 
Thus, the western Indian Ocean XBT training workshop was successful and concluded 
satisfactorily. 
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Annexure – 1 
 
Announcement 
 
International Workshop IOGOOS/JCOMM Western Indian Ocean  
Expendable Bathythermograph (XBT) Training Workshop 
 
The National Institute of Oceanography (NIO), Goa, India is hosting an international 
workshop “IOGOOS/JCOMM Western Indian Ocean Expendable Bathythermograph 
(XBT) Training Workshop” during 5-7 October 2005 at Hotel Marriott, Miramar, Goa, 
India.  
 
The UNESCO’s Intergovernmental Oceanographic Commission (IOC) is funding this 
event. We at NIO are in close coordination with the regional Indian Ocean Global Ocean 
Observing System (IOGOOS), the WMO/IOC Joint Technical Commission for 
Oceanography and Marine Meteorology’s (JCOMM) Ship of Opportunity Implementation 
Panel (SOOPIP), the CLIVAR/GOOS Indian Ocean Panel (IOP) and IOC Perth Regional 
Office.   
 
Target Participants:  
 
Operational Managers and Technical Support staff from regional (Indian Ocean) 
Expendable Bathythermograph (XBT) programs. Shipping agents, scientists, 
transportation officials, ship crews, port ship greeters, Port Meteorological Officers 
(PMO) and other personnel will be trained in logistical and implementation topics such as 
receiving XBT shipments, facilitating their clearance through customs, delivering the 
shipment to the appropriate in-country agency and then forwarding it to ports for 
deployment, coordinating with port authorities, installing equipment on ships, XBT 
deployment, SEAS Training and other operations and logistics related to XBT operations.  
 
Goals of the Workshop: 
 
To build the very much needed regional capacity to enhance XBT observations in the 
sparsely sampled western Indian Ocean and to ensure that these operations are sustained 
Reestablish XBT line route IX-08 (Mumbai and Mauritius), 
Reestablish XBT line route IX-06 (Mauritius to Malacca Straits), 
Reestablish XBT line route IX-21 (Cape of Good Hope to Mauritius), 
Reestablish XBT line route IX-15 (Fremantle to Mauritius), 
Provide SEAS (Shipboard Environmental (data) Acquisition Systems) unit training for 
regional technical support staff. 
Develop logistical support procedures including the import of scientific instrumentation 
into country(s). 
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Develop recruiting procedures for Voluntary Observing Ships. 
 
It is expected that this workshop will significantly enhance in-situ ocean observations in 
the sparsely sampled Western Indian Ocean, provide complementary data to that currently 
being provided by Argo floats and other existing and planned in-situ networks, fill an 
existing gap for the “Global Earth Observation System of Systems (GEOSS)” ten-year 
implementation plan, and build the desperately needed regional capacity to ensure that 
these XBT operations are sustained in the Western Indian Ocean. 
 
Dr. V.S.N. Murty,  
Chair, WIO XBT Workshop 
  
Organizing Committee 
1. V.S.N. Murty   -NIO, Chair     vsnmurty@darya.nio.org 
2. V.V. Gopalakrishna -NIO     gopal@darya.nio.org 
3.  T. Srinivasa Kumar -IOGOOS Secretariat  srinivas@incois.gov.in 
4.  William Erb  -IOC Perth Regional Office w.erb@bom.gov.au 
5. Gary Meyers  -CSIRIO, Chair, IOP  gary.meyers@csiro.au 
6.  Steve Cook  -NOAA, Chair SOOPIP   steven.cook@noaa.gov 
7.  Clark Candyce   -NOAA, JCOMM, Paris  c.clark@unesco.org 
8.  Sidney W. Thurston -NOAA OCO             Sidney.thurston@noaa.gov 
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Annexure - 2 
Workshop Agenda  
 
4 October 2005    - Arrival of participants at Hotel Marriott, Goa 
4 October 2005 1900-2130 -  Ice-breaker meeting at Hotel Marriott 
 
Workshop Venue : Hotel Marriott, Miramar, Goa 
 
Day 1: 5 October 2005 
 
0930 – 0940    Welcome to the invitees – Chairman   – V.S.N. Murty, NIO 
0940 – 0950    Opening remarks               – Sidney Thurston, NOAA 
0950 – 1000    XBT observations in Indian Ocean – IOP Chair – Gary Meyers, CSIRO 
1000 – 1010    XBT observations: Indian initiatives            - P. Sanjeeva Rao, DST, 

   New Delhi 
1020 – 1030   Ocean Observing System in the northern   - K. Somasundar, DOD 
     Indian Ocean: Indian Perspective        New Delhi 
1030 – 1040    SOOPIP, Chair      - Steven Cook 
1040 -  1050    JCOMM Initiatives     - Regina Folorunsho 
 
1100 – 1130 Tea break 
 
1130 – 1140 Introduction of the invitees from the Shipping Corporation of India (SCI), 

Customs, Private Shipping Personnel, Indian Navy  
1140 – 1210 XBT observations in the Indian Ocean: Scientific results  
   along Perth – Red Sea route and Australia – Java Routes 
  – Gary Meyers 
1210 – 1225 XBT observations in the IO: Scientific results of Lakshadweep Sea   

 – VV Gopalakrishna 
1225 – 1240 XBT observations in the IO (IX-08): Scientific results along Mumbai – 
  Mauritius shipping route  

– VSN Murty 
1240 - 1250 XBT observations in the IO (IX-22, PX-02): Summary of Australian efforts  

- Lisa Cowen 
1250 - 1300 South African’s interests and plans in the western Indian Ocean  

- Chris Reason 
 

1300 – 1430 Lunch 
 
1430 - 1450  Presentation by Mr. Mukund Shinde, Customs Appraisal, Goa  
1450 - 1510 Presentation by Capt. Praveen Kumar, Official from Shipping Corporation of 

India, Mumbai  
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1510- 1530  Discussion     
 
1530 – 1600 Tea Break 
 
1610 – 1620  R&D activities of the Kenya Marine Fisheries & Research Institute 

 (KMFRI) and their possible plans of XBT observations  
  in the IO  

- Charles Magori 
1620 – 1640 Present and Planned research activities of NARA, Sri Lanka in the IO   

- Arulananthan  
1640 – 1650 XBT observations in the IO: Activities at the First Institute of Oceanography 

(FIO), Qingdao, China 
  - Baoquiang Xiang 
1650 – 1700 XBT observations in the eastern Indonesia and research activities of the 
  Center for Maritime and Fisheries Research, Indonesia 
    - Anastasia Rita Tisiana Dwi Kuswardani 
1700 – 1710 Research activities at Mauritius Oceanographic Institute (MOI)   
  - Mitrasen Bhikajee   
1710 – 1720 Marine activities at Mauritius Marine Meteorological Section  
  - Ashok Gopaul 
1720 - 1730 Fisheries Research activities in the Republic of Seychelles 
  - Roland Azemia 
 
1900 – 2100 Dinner  
 
Day 2:  6 October 2005  
 
0930 – 1100 Demonstration and training on AMVER/SEAS 2000 System to the 
  invitees and NIO research students   
  - Steve Cook 
 
1100 – 1130 Tea break 
 
1130 – 1220 Quality Control of XBT data, Procedures from the Australian Bureau of 

Meteorology, the CSIRO Cookbook and GTSPP 
- Lisa Cowen   

1220 – 1230 XBT observations in the Southern Indian Ocean 
  - Anil Kumar 

1230 – 1330  Lunch 
 
1430 – 1530 Visit to NIO    
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1530 – 1600 Tea break 
 
1600 – 1700   Seminar by Gary Meyers at NIO ‘ Cardium’ 
 
1700     Back to Hotel 
1830 – 2100  Boat cruise in the Mandovi Estuary and onboard Dinner  
 
Day 3: 7 October 2005 
 
0900 – 1030  Workshop concluding session and discussion on report preparation 
1030 – 1100  Tea Break 
 
1100 - 1130   Concluding and Vote of Thanks 
 
1130 onwards:  Lunch and Departure of participants 
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Annexure – 3 
 

List of foreign Participants to the workshop 
 

Sl. No.  Name, affiliation and addresses of foreign participants  
 

1. Dr. Sidney Walter Thurston III 
Office of Climate Observation, NOAA 
1100 Wayne Avenue, Suite 1210 
Silver Spring, Maryland 20910 
USA  
Tel. No. +1 301 427 2329 
Fax No. +1 301 427 0033 
e-mail: Sidney.Thurston@noaa.gov  

2. Mr. Steven Kenneth Cook 
NOAA, OAR, AOML 
GOOS Center 
8604 La Jolla Shores Dr. 
La Jolla, CA 92037 
USA 
Voice: 858-546-7103 
Fax: 858-546-7185 
Email: Steven.Cook@noaa.gov  

3. Dr. Gary Albert Meyers 
CLIVAR/IOC Indian Ocean Panel - Chair 
CSIRO Marine and Atmospheric Research 
P.O. Box 1538,  
Hobart TAS 7001, Australia 
e-mail: Gary.Meyers@csiro.au  

4. Dr Regina Folorunsho 
Nigerian Institute for Oceanography and Marine Research 
PMB 12729 
Victoria Island 
LAGOS 
Nigeria 
Telephone: +234-1 2619517 
Telefax: +234-1 261 9517, 262 9738 
e-mail: niomr@linkserve.com.ng  
e-mail: rfolorunsho@yahoo.com  

5. Dr. Alui Bin Bahari 
Director of Marine Meteorology and Oceanography 
Malaysian Meteorological Department. 
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Jalan Sultan 
46667 PETALING JAYA 
Malaysia 
Tel: 603 - 7967 8080 
Fax: 603 - 7957 8046 
e-mail: alui@kjc.gov.my  

6. Ms. Anastasia Rita Tisiana Dwi Kuswardani 
Research Center for Maritime Territories and Non-living 
Resources 
Agency for Marine and Fisheries Research 
Jl. M.T. Haryono Kav 52-53 
Jakarta 12770 
Phone : +62-21-79180303 ext 2368 
Fax          : +62-21-79191202 
e-mail: tisiana@lycos.com 

7. Dr. K. Arulananthan,  
Head of the Oceanography Division 
National Aquatic Resources Research & Development 
Agency 
Crow Island., Colombo 15. 
Sri Lanka 
TP : 0094-11-2521008 (Office) 
FAX: 0094-11-2521932 
e-mail: arul@nara.ac.lk  

8. Mr. Ashok Gopaul 
Principal Meteorological Technician 
Head Marine Meteorology Section 
Mauritius Meteorological Services  
Mauritius 
Fax No. 230 686 1033 
e-mail: mauritius meteorological services   

9. Dr. Charles Magori 
Research Scientist 
Kenya Marine  & Fisheries Research Institute  
P.O. Box 81651  
Mombassa 80100  
Kenya  
Tel: +254 722 475565 
Fax: +254  41 475157 
e-mail: cmagori@kmfri.co.ke  
e-mail: cmagori@yahoo.com  
 

 25

mailto:alui@kjc.gov.my
mailto:tisiana@lycos.com
mailto:arul@nara.ac.lk
mailto:cmagori@kmfri.co.ke
mailto:cmagori@yahoo.com


10. Dr. Christopher James Charles Reason 
Oceanography Department 
University of Cape Town 
Private Bag 
Rondebosch  
7701 South Africa 
e-mail: cjr@egs.uct.ac.za  
tel 27-21-650-5311 
fax 27-21-650-3979 

11. Dr. Juliet Clair Hermes 
Oceanography Department 
University of Cape Town 
Private Bag 
Rondebosch  
7701 South Africa 
e-mail: cjr@egs.uct.ac.za  
e-mail: jhermes@ocean.uct.ac.za  
Tel 27-21-650-5311 
Fax 27-21-650-3979 
 

12. Dr.  Lisa Cowen 
Bureau of Meteorology 
Marine Operations Group 
GPO Box 1289 
Melbourne, VIC 3001 
Australia 
Tel: +61 3 9669 4155 
Fax: +61 3 9669 4168 
Email: l.cowen@bom.gov.au  

13. Dr. Mitrasen Bhikajee 
Mauritius  Oceanography Institute  
France Centre,  
Victoria Avenue  
Quatre Bornes 
Mauritius 
Tel:  +230 427-4432 (office) 
Fax: +230 427-4433 
e-mail: moi@intnet.mu  

14. Mr. Roland Thomas Azemia, 
Seychelles Fishing Authority 
P.O.BOX 449 
Fishing Port,  
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Mahe  
Seychelles Islands 
Tel: +248 224597 
Fax: +248 224508 
e-mail: razemia@sfa.sc  

15. Mr. Baoqiang Xiang 
The First Institute of Oceanography 
State Oceanic Administration 
P. R. China 
No. 6 Xian-Xia-Ling Road,  
Qingdao 266061  
Tel: 86-532-88960702 
Fax: 86-532-88967403 
e-mail: xiangbq@fio.org.cn  
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Annexure 4 
 

Indian Participants (including the LOC members) 
Sl. 
No.     

Name of the Invitee   Institution/Organization 

1. Dr.S.R.Shetye,  
Director 
Phone.+91-(0)832-2450 201
Fax     +91-(0)832-2450 602
shetye@darya.nio.org  

National Institute of 
Oceanography                              
Dona Paula,  
Goa – 403 004, India 

2. Dr. V.S.N. Murty  
Chairman of the Workshop 
Phone.+91-(0)832-2450 460
Fax     +91-(0)832-2450 608
vsnmurty@darya.nio.org 

NIO 

3 Dr. V.V. Gopalakrishana 
Scientist 
gopal@darya.nio.org 

NIO 

4. Dr. N. B. Bhosle,  
Scientist 
bhosle@darya.nio.org  

NIO 

5. Dr. M.D. Rajagopal 
Scientist 
rgopal@darya.nio.org  

NIO 

6 Dr. R.G. Prabhu Desai 
Scientist 
prabhu@darya.nio.org  

NIO 

7. Dr. Y.K.Somayajulu 
Scientist 
yksoma@darya.nio.org  

NIO 

8. Dr. S. Prasanna Kumar 
Scientist 
prasanna@darya.nio.org  

NIO 

9 Mr. M.S.S.Sarma 
Scientist 
msarma@darya.nio.org  

NIO 

10. Mr. P.N.Muralidharan 
Scientist 
murali@darya.nio.org  

NIO 

11. Mr. Dasmond Gracias, 
Technical Officer 
dasmond@darya.nio.org  

NIO 
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12. Mr. Areef Sardar,  
Technical Officer 
areef@darya.nio.org  
 

NIO 

13. Mr. Jonney Maschernas, 
Dy. Stores and Purchase 
Officer 
johnny@darya.nio.org  

NIO 

14 Mr. C.M.Dais,  
Finance and Accounts 
Officer 
cmdias@darya.nio.org  

NIO 

15 Mr. A. Muthkrishnan,  
Controller of 
Administration  
krishnan@darya.nio.org  

NIO 

16. Mr. Suresh Pant, 
Stores and Purchase Officer 

NIO 

17 Dr. P. Sanjeeva Rao,  
Director 
psrao@alpha.ren.nic.in  

Earth Sciences Division 
Department of Science & 
Technology (DST) 
Technology Bhavan 
New Meharuli Road 
New Delhi 

18 Dr. K. Somasundar,  
Scientist 
somasundar@ren.nic.in  

Department of Ocean 
Development (DOD), 
Mahasagar Bhavan 
Block -12, C.G.O. Complex  
Lodi Road 
New Delhi  

19 Cmdr. M. Sarangapani  INS Hamsa, 
Indian Navy 
Vasco-da-Gama 
Goa 

20 Dr. Shailesh M. Pednekar,  
Scientist 
shailesh@ncaor.org  

National Center for Antarctic 
and Ocean Research 
(NCAOR), 
Department of Ocean 
Development (DOD) 
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Annexure 5 

 

Welcome address by the Chairman   

  
It is indeed an honour for me to be the Chairman of this international workshop on the 
“IOGOOS/JCOMM Western Indian Ocean Expendable Bathythermograph (XBT) 
Training Workshop” for organizing and also inaugurating this international workshop at 
The Hotel Marriott, Miramar, Goa. On behalf of the Director of NIO and my own behalf, 
it is my immense pleasure to welcome Dr. Sidney Thurston, Manager, Office of Climate 
Observation (OCO) Program, NOAA, US, Dr. Gary Meyers, CSIRO, Hobart and 
Chairman, CLIVAR/GOOS Indian Ocean Panel, Dr. Steven Cook, Chairman, SOOPIP, 
NOAA, US and all the invitees from the Indian Organizations such as the NIO, NCAOR, 
DST, DOD, DNOM (Indian Navy), SCI, Customs and Central Excise.  
 
I especially welcome the invitees who have come all the way traveling from the Indian 
Ocean rim countries such as Australia, South Africa, Malaysia, Indonesia, Sri Lanka, 
Seychelles Islands, Mauritius, Nigeria and Kenya and from China.  
 
The NIO has been in close coordination with the regional Indian Ocean Global Ocean 
Observing System (IOGOOS), the WMO/IOC Joint Technical Commission for 
Oceanography and Marine Meteorology’s (JCOMM) Ship of Opportunity Implementation 
Panel (SOOPIP), the CLIVAR/GOOS Indian Ocean Panel and IOC Perth Regional Office.   
 
The participants in this workshop do cover the Operational Managers and Technical 
Support staff from regional (Indian Ocean) Expendable Bathythermograph (XBT) 
programmes, shipping agents, scientists, custom officials and research students. During 
the workshop, the participants will be trained in various aspects dealing with the XBT 
temperature measurements, XBT data quality control measures, and also will be trained to 
the use of specially procured Shipborne Environmental (data) Acquisition System (SEAS). 
  
It is expected that the presentations by the invitees and demonstration of the SEAS would 
help the invitees to learn more about the XBT measurements, and would enhance the very 
much needed regional capacity to ensure that the XBT operations are sustained in the 
Western Indian Ocean. 
 
Once again I welcome you all to Goa and to the workshop. 
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Annexure 6 
 

Opening Remarks by Dr. Sidney Thurston, NOAA Office of Climate Observation. 
 

Thank you Dr. Murty, Mr. Chairman, Dr. Gary Meyers, Chair of the Indian Ocean Panel, 
Dr. Steven Cook, Chair of the Ship of Opportunity Implementation Panel, Dear 
Colleagues, it is a distinct privilege and honor for me to be with you this week in beautiful 
Goa, India to coordinate XBT operations for the Western Indian Ocean.  As we get started 
I would first like to recognize and thank Dr. Murty, Dr. Shetye and Dr. Gopalakrishna and 
the Local Organizing Committee for their truly outstanding hospitality and fine 
arrangements.   Thank you all for traveling long distances away from your Families and 
homes so that we may meet personally this week to come to a common understanding.   
With all of our modern information technology today, there is still no substitute for 
personal relationships. 
 
Science and technology are giving us a remarkable capability to observe and, with the 
resulting observations, understand the Earth as a system.  Today there is an unprecedented 
convergence of sophisticated platform and sensor technology, super-computing 
horsepower and communication throughput.  This scientific understanding in turn 
provides us with a means to enhance our operational predictive capabilities to meet a 
variety of pressing societal needs. All this begins with Observations, the first step in the 
scientific process.  As many of you know, there is a new framework for sustaining Earth 
Observations; the Global Earth Observation System of Systems (GEOSS).   GEOSS is not 
just about making observations but also about applying this information for benefits to 
society such as mitigating natural disasters, improving weather forecasts and warnings, 
monitoring climate change, protecting human life, managing fisheries, and exploring the 
oceans – just to name a few.  All of this begins with observations and their importance is 
now recognized by world leaders through the GEOSS Initiative.  Just two months ago in 
Scotland, the members of the G-8 welcomed the adoption of the GEOSS 10-year 
Implementation Plan in their “G-8 Glen Eagles Plan of Action”. We at NOAA are excited 
about the prospects that, for the first time in the history of civilization, the global scientific 
community is on the cusp of having the capability to observe nature on nature’s scales.  
 
The United States Contribution to GEOSS is the Integrated Earth Observation System 
(IEOS).  IEOS will meet our Country’s needs for high-quality, global and sustained 
information on the state of the earth for policy decisions makers in every sector of our 
society. The U.S. ocean contribution to IEOS and GEOSS will be the Integrated Ocean 
Observing System (IOOS) which will have coastal components and a global component.  
The NOAA Office of Climate Observation (OCO) is tasked with the implementation and 
management of the IOOS Global component. 
The Mission of OCO is to Build and sustain a global climate observing system that will 
respond to the long-term observational requirements of the operational forecast centers, 
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international research programs, and major scientific assessments. The OCO Objectives 
are to: 1) Document long term trends in sea level change, 2) Document ocean carbon 
sources and sinks, 3) Document the ocean’s storage and global transport of heat and fresh 
water and 4) Document the ocean-atmosphere exchange of heat and fresh water.  With this 
mission and objectives, OCO was established to manage the implementation of NOAA’s 
in-situ, operational ocean observations for climate to include: the Tropical Atmosphere 
Ocean (TAO) Array of moorings in the equatorial Pacific, the Global Surface Drifters 
Array, the Global Sea Level Network, Volunteer observing ships, the Global XBT 
Network, the Global Carbon and Hydrographic Surveys and Ocean Reference Stations.    
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Annexure – 7 

 
List of participants attended the SEAS unit demonstration 

 
Sl. 
No. 

Name of participant Designation E-mail ID 

1 Mr. Anselam 
Almeida 

Technical 
Officer 

anselm@nio.org 

2 Mr. R. J. K. 
Charyulu 

Scientist E II charyulu@nio.org 

3 Mr. S. Murali 
Krishna 

Project 
Assistant 

oceanographer@rediffmail.
com 

4 Mr. P.S.V. Jagdeesh Project 
Assistant 

vjagadeesh@nio.org 

5 Mr. Nagraju Project 
Assistant 

Ocean_raju@yahoo.co.uk 

6 Mr. Nuncio 
Murukesh 

Research 
fellow 

nuncio@nio.org 

7 Ms. Jayu V. 
Narvekar 

Research 
fellow 

jnarvekar@nio.org 

8 Ms. M. Deepthi Project 
Assistant 

Deepthi_oceans@yahoo.co.
in 

9 Ms. Nisha Kurian Project 
Assistant 

neeshakurian@gmail.com 

10 Mr.Gourish 
Salgaonkar 

Project 
Assistant 

gsalgaonkar@nio.org 

11 Ms. Leena 
Shirgaonkar 

Project 
Assistant 

l_shirgaonkar@yahoo.co.in 

12 Ms. Madhumita 
Tripathy 

Student madhumitageo@rediffmail.
com 

13 Mr. Mohammad 
Alsafani 

Research 
Fellow 

alsafany@nio.org 

14 Mr. Johnson 
 Zacharia 

Project 
Assistant 

Johnson_Zacharia@yahoo.c
o.uk 

15 Mr. Annesh Kumar Research 
Fellow 

aneeshkumar@email.com 
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Annexure 8 

 
Seminar by Dr. Gary Meyers 
 
Title: "The years of El Nino, La Nina and interactions with the tropical 
Indian Ocean" 
 
Abstract 
 
The Indian Ocean Zonal Dipole is a mode of variability in sea surface 
temperature that seriously affects the climate of many nations around 
the Indian Ocean rim, as well as the global climate system. It has been 
the subject of increasing research, and sometimes scientific debate 
concerning its existence/non-existence and dependence/independence of El 
Nino Southern Oscillation, since it was first clearly identified in 
Nature in 1999. Much of the debate occurred because people did not agree 
on what years are the El Nino or La Nina years, not to mention the newly 
defined years of the positive or negative Dipole. We propose a method 
that identifies when the positive or negative extrema of El Nino 
Southern Oscillation and Indian Ocean Dipole occur, and use the method 
to classify each year from 1876 to 1999. The method is statistical in 
nature, but has a strong basis on the oceanic physical mechanisms that 
control variability of the near equatorial Indo-Pacific basin. Early in 
the study we found that some years cannot be clearly classified for a 
variety of reasons, and these years also must be recognized, with the 
reason for their ambiguity. We test the sensitivity of the 
classification of years by calculating composite-maps of Indo-Pacific 
SST anomaly and probability of below median Australian rainfall for 
different categories of the El Nino-Dipole relationship. Finally, in 
order to describe, understand and predict ENSO and the dipole in the 
Indian Ocean, the CLIVAR/GOOS Indian Ocean Panel has prepared an 
implementation plan for sustained, basin-scale ocean observations. 
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Annexure 9 
 
Following are the proposed milestones by Dr. Sidney Thurston for the ‘Goa Plan of 
Action 2005’  
 
1. October, 2005:   Western Indian Ocean XBT Training Workshop, Goa India 

 
2. October, 2005:   IOC Provides NIO With SEAS Equipment, NOAA Provides  

 SEAS Training and Inmarsat Communications Costs when SEAS is  
  operationally contributing to a revitalized IX-8 XBT Line.   

 
3. November, 2005: NOAA Commences Shipping of 5 Cases of XBTs to NIO to 
                                  Support 50% of IX-8 and notifies Goa customs to expect 
                                  Shipment 

 
4. December, 2005:  NIO Convenes Meeting with SCI in Goa “The Next  
 Generation of Indian Ocean Observations” 
 
5. January, 2006:   IX-8 Ship Identified, Logistical Arrangements Commenced 

 
6. January, 2006:   NOAA’s 5 Cases of XBTs arrive at NIO to Support 50% of  
 IX-8 

 
7. March, 2006:   Eastern Indian Ocean Capacity Building Workshop, “Use of 
                                 Ocean Observations to Enhance Sustainable Development”,  
 Bali 

 
8. April, 2006:   IX-8 Operational, Unrestricted Data Available in Real-Time  
 Over GTS and the Internet 
 
9. June, 2006:   Follow-up Western Indian Ocean Training and Capacity  
 Building Workshop in Mauritius 

 
10. October 2006:   SOOPIP Meeting at SOT-4, IX-8 Results Presented along 
  with Other Indian Ocean XBT Lines 
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Annexure -10   

Operating SEAS2000 Hand Launch Only – System Ver 1.0 
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1.)  Amver Seas Hardware 
Hardware List: 
Power: 
• 240 VAC appropriate power leads and strips. Equipment below needs 7 outlets. Use an 

8 outlet power strip or a 6 outlet strip and the power outlet on the Thrane & Thrane 
power converter. 

• Plug adaptor(s). Appropriate power cords, depending on type of strip used. 
• Cheater plug to float off of ships ground – use cheater plug on power strip so all 

equipment is floated 
• Ground wire - From Connector Box or Hand Launcher to hull (use handy porthole 

window screw).  
• 2nd Ground wire - connect hull ground to ground screw on Thrane & Thrane.  See 

Figure 2 
Computer: 
• Shuttle computer. 
• Shuttle Flat screen Monitor. 
• Keyboard. 
• Mouse. 
 
MK21: 
• MK21 card in powered USB Enclosure. 
• Connector  Box Used for MK21. 
• Hand Launcher. 
• MK21 Cable – Connector  Box to MK21 USB Box. 
• Cable - Connector  Box to Hand Launcher. 
 
Transmitter and GPS: 
• Thrane & Thrane Transceiver with Antennae & power adaptor (extra power port here).  
• Serial Cable – Thrane & Thrane to P.C. – COM1. 
 
Data Storage: 
• USB Micro Drive – 512MB is a good size for backing up data or transferring files. 

Do not leave it in the USB port – it can offset XBT data. Plug it in to the powered hub 
(if available) to be safer. 
• Blank CD's for backups.  

Software: 
• WinMK21 for Windows. 
• NOAA AmverSeas. 
• Cap Sat - Thrane and Thrane Software. 
• Easy Mail Software. 
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Hardware Setup 
Please read the Sippican Inc “MK-21/USB Installation, Operation and 

Maintenance Manual” (Sipp Op Doc.).  Give particular attention to sections: 3.1 – 
3.1.4, 3.1.6, 4.1, 4.2 These sections cover the proper turn on and off sequences of the 
MK21 and computers. 

MK21 USB Box should be set up with all power OFF. Then the MK21 USB 
Box is started before anything else. This insures that no voltages enter the MK21 
USB Box while it is off. This has been known to damage MK21 cards. 

1) Start With Everything Off, Computer off, MK21 USB off . 
2) Plug Thrane & Thrane into Comm 1 of the shuttle.  (T& T can be on or off.) 
3) Plug, MK21 USB Box (switched off) into 100-240 VAC , 50-60 HZ  power 

source. (3.1.4 Sipp Op Doc.). 
4) Plug the cable from the Connector Box into MK21 USB Box. (3.1.6 Sipp Op 

Doc.) 
5) Plug the MK21 USB Cable into back of the computer.  (3.1.3 Sipp Op Doc.) 
6) Now POWER UP The MK 21USB Box. (3.1.4 & 4.1 Sipp Op Doc.) 
7) Power up the computer and Log on. (4.1 Sipp Op Doc.) 
8) Restart the computer. Computer may not recognize the MK21 unless computer is 

restarted with USB plugged in. 
9) Ground Connector Box.  (See Appendix 2 or 3.1.6 Sipp Op Manual) 
10) When turning off system, The MK-21USB should be the LAST POWERED 

OFF.  ( 4.2  Sipp Op Doc) 
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Figure 1 XBT Hand Launcher wiring diagram 
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2. )  Software Installation 
Installation of WinMk21 Surface Software from Sippican, Inc:  

These steps may not be necessary as “WinMk21 Surface” Software may already be 
installed on your computer.  If this is the case then move on to Amver Seas software 
installation.  It is installed if there is “Program Files / Sippican” directory, additionally 
there should be a “WinMk21” Logo on the desktop.  Double click this logo to run the 
software. 

If “WinMk21 Surface” Software is not installed then install it. See section 2.2 of the 
Sippican Inc.  “MK-21/USB Installation, Operation and Maintenance Manual” (Sipp Op 
Doc.).   

When the computer is first turned on with the Mk21 USB plugged into the back of 
the computer windows XP will detect new Hardware and ask you to install the drivers.  
See section 3.1.4.1 of the “Sipp Op Doc”.   

Please Insure the system is up and running with “WinMk21 Surface” Software 
before proceeding with “Amver Seas” software.  Instructions for testing the Mk 21 using 
the “WinMk21 Surface” Software are in sections 4.1 - 4.3 of the “Sipp Op Doc”. 

The “WinMk21 Surface” Software is not used to drop XBT’s during the cruise, 
always use the “Amver Seas” Software! 
 
Installation of New Amver Seas Software:  
These steps may not be necessary as the correct version of Amver Seas may already be 
installed on your computer.  If this is the case then move on to step III. 

Generally: 
1. Rename existing AMVERSEAS directory (usually  C:\Program 

Files\AMVERSEAS)  to AMVERSEAS_old or similar. 
2. Right mouse click on the Windows:  Start > Properties > Start Menu (tab) > 

Customize  > Advanced. Go to “…\Start Menu\Programs\Startup” in the 
Explorer Window that pops up. 

3. DELETE THE EXISTING shortcut to AMVERSEAS.exe 
4. Install AMVERSEAS by double clicking “setup.exe” on Amver Seas install 

CD. This will walk you through the Amver Seas install procedure. 
5. In “C:\Program Files\AMVERSEAS”,  right mouse click on newly installed 

“AMVERSEAS.exe” > Create shortcut. Move that shortcut to “...\Start 
Menu\Programs\Startup” (step 2). This will open AMVERSEAS  (and Time 
Sever, Transceiver, XBT Program, and Auto IMET if enabled) upon booting, 
provided there is only one user on the computer.  Double check that shortcut is 
pointing to the appropriate target usually: 

 “C:\Program Files\AMVERSEAS\AMVERSEAS.EXE”. 
6. Often the Admin.txt from the “Administration” folder of the original 

AMVERSEAS folder can be copied and pasted to the new AMVERSEAS 
directory. This keeps original ship info.  Also XverSetup.txt & Automet.txt. 
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3.)  Amver Seas Software Setup 
Setup from Amver Seas Main Menu: 
 

 
Figure 2 AMVER SEAS Main Menu 

 
The following programs start on their own when the computer is turned on. 

a. Amver Seas – All other programs can be opened from here. You may need to set 
up Administration upon opening for the first time. 
b.Transceiver Interface.  
c. XBT Program. 

If the programs do not start on their own they need to be setup from the Amver Seas 
Main Menu. Transceiver program can be started from the “Setup | Transceiver | Start 
button”.  The XBT program can be started by selecting “XBT button”. 

 
View Html Help Pages.   

Go to menu item “Help | Help”.  This will open a very detailed and thorough help 
guide. 

Set System Clock: 
 Please set the system clock to “Casablanca Monrovia” Time Zone.  Make 
sure that the computer is displaying the correct date and time.  It should match the 
UTC date and time.  In order to do this: double click the time showing at the bottom 
right of the computer screen. When the “Time and Date Properties” dialog appears, 
select “Time Zone” tab and select “Casablanca Monrovia” as the time zone.  Then 
put in the correct date and time using the “Date & Time” tab. 
 
AMVER Button refers to “sail’, “dev”, “pos” and “arrv” buttons below and is not 
applicable for systems doing XBT only. 
 
SEAS Button used to enable “Meteorological”, “XBT” or “TESAC” Observations. 

Setup Button used to Enable Administration Program. 
 1.  Select “Administration”. 
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 2.  Fill out “Administration” screen (note “Mandatory” fields) 
  a. Ships name. 
  b. Ships Call Sign. 
  c. Maximum Ship Speed. 
  d. Inmarsat Std. C number. 
  e. Medical Staff. 
 3.  Select “Transmit Binary”. 
 4.  Select “Browse” to save for later transmission. 
 5.  Save in “Reports_Amver/Admin (default). 
 6.  Select “OK”. 
 
Return to “Setup” and Enable XBT Program. 
 1. Select “XBT”. 
 2.  Enable “XBT”, if not already. 
 3.  Select “OK”. 
 
Return to “Setup” and Enable Transceiver Program 

1. Select “Transceiver Enabled”.  
 This will also activate “Automatic Binary File Transmission”. 

 2.  Alternate NEMA GPS is not applicable for Hand Launch XBT operation. 
 3.  Transceiver Settings should default as follows: 
  a. Com Port = 1. 
  b. Enter X.25 Address from pull down menu. 
 4.  Enter appropriate “Coast Earth Station” from pull down menu. 
 5.  Select “Start”. 
 6.  Selecting “OK” will save for later transmission. 
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                  Figure 3 Transceiver Setup 

 
 

Enable XBT Program from SEAS Button on main AMVER SEAS Screen. 
 
 1.  XBT program will start automatically with opening Amver Seas, once 
XBT has been  enabled. 
 2.  From the XBT Graphs Screen select “Setup” and then “System” and 
then “XBT  Instrumentation” 

  a. Choose the type of probe you are using. Should be “Deep Blue”. Make 
sure the  recorder type is MK-21 and the Terminal depth is 1000m. 
  b. Select “OK”. 
 3.  Return to  “Setup | System | System Configuration”: 

  a. Make sure the information is correct for your cruise from the Amver Seas 
Admin   screen i.e.: “Ship Name”, “Call Sign, “IMO Number”. 
  b.  Set “Scale of Graph”.  (Usually -2 to 32 Deg. C) 
  c.  Set “Launch Probe Type” to “Hand Launch”. 
  d.  Set “Transmit” to “Automatic Transmit Binary Real-Time XBT” to “On”. 
  e.  Set “Data Type” to “Full Resolution”. 
  f.  Set “Query Reduction” to “Save Binary File without Question”. 
  g.  Input of XBT probe serial number is optional. 
  h.  Select “OK” 
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     Figure 4 System Configuration 
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Transceiver Program Operation: 
(Once it is up and running). 
When the transceiver is up and running it should look like figure 5. The transceiver 
Program reads the GPS position and time for use by the system as well as 
transmitting binary message.    

               
   
                         Figure 5 Transceiver Status 
 

Display: 
Transceiver Status:  Displays current status of transceiver. 
GPS Data: Position and Time information displayed is from the Thrane and Thrane  
GPS. 
Last Files Xmitted: When a binary message is sent to the transmitter its status is 
displayed on the front of the Transceiver Interface window.  The status “Acknowl” 
standing for Acknowledged is what should be seen after the binary file has been 
transmitted.  Any other status means that the  message was not transmitted.  

Menu items: 
Stations:  Allows view of current land earth station or to select a new station.  The 
stations are originally set in the Amver Seas main menu.  User can also select a new 
station.  Open up “Select New” stations dialog and then double click on station in 
“Allowed Station” list box to select new station.  
Command Interface: This opens a window allows for interacting directly with the 
Thrane & Thrane transceiver.  The window is reached by selecting “Transceiver | 
Command Interface”.   There are various status buttons: 
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The “Transmit” Status button should display the information about all the 
recently transmitted files.  
The “Hardware” Status button should display the local oscillator and offsets, 
antenna receive and transmit current, and signal strength 
The “GPS Receiver” status button should display the navigational status, the 
number of visible satellites, software version of the GPs module, navigation mode, 
figure of merit (estimated position error), UTC, numbers representing the 
geometric properties of the satellites and positional error, and satellite tracking 
status.   
The “Position and Time” button of course displays the GPs position and time. 
The “Transceiver Command” edit box (small box in upper right corner) allows 
the user to input any Thrane and Thrane command and see the response in the 
“Command Response” field. 
 

Utilities: 
Check For Files To Transmit: Will transmit all files located in the “C:\Program 
Files \ Amver Seas\ Transceiver \ Xmit directory”.  Please only select this feature 
when there are not files currently waiting to be transmitted. 
View Transmit Log: Opens up the transmit log so that the user can view the status 
of the last few hundred transmissions. Once the log is greater than 50K then the 
Log is moved to the 2nd transmit log and a new transmit log is begun. 
View 2nd Transmit Log: Allows the user to view the 2nd transmit log. See entry 
above. 
Change Transmission Type: Allows for SEAS or X.25 transmission.  This option 
should never be used as all transmissions are of type SEAS. 
Allow NEMA: This feature is not used at this time. 
 

XBT Program Operation.  
(Once it is up and running). 
 

 
 

Start the XBT program from the Amver Seas Main Menu.  It may already be up because 
it will start automatically from Amver Seas program.  The XBT program reads the data 
from dropped XBT’s.  The data is displayed real-time on a graph.  If set up to do so, 
binary messages are automatically transmitted as well. 
Many of the items in the XBT Program main menu are disabled for Hand Launcher Only 
systems. 
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Launching from the XBT Program: 

 1. Press the  button.  
2. Waiting for “Connection to Mark 21 I/O” dialog will pop up on first launch.  The 
MK21 card will click twice indicating that the MK21 card is responding. 
3. Screen will display “Spent Canister/ Load Probe” if Hand Launcher (HL) contains 
a probe. If empty, it will display “Unknown / Load Probe” and then move to 
“Empty/ Load Probe”.   
4. Open the Latch on the HL. Wait for screen to display “Empty/ Load Probe”. This 
will take a few secsonds. Load the XBT Probe, and then close latch. More clicking 
noises should be heard from the MK21 card. 
5. Screen will then display “New Canister / Testing Probe” then “New Canister / 
Prepare for Launch” then “New Canister / Launch Probe”. At this point launch XBT 
probe in the water. 
6.  Program should now say “New Canister / Collecting Data”.  The graph of the data 
will appear.                                                              
 

Menu Items:  (XBT Program) 
File: 

Open binary:  Choose which binary file you want to open in the main XBT window. 
Use Ctl or Shift to select multiples 
Copy Binary JJVV's:  Transfers  binary files.  
Save ASCII for Export:  Converts NOAA XBT  YYMMDDN##.bin data to  full 
resolution, 2 meter or inflection point ASCII text files. 
Save ASCII JJYY:  Converts NOAA SBT YYMMDDN##.bin data to 2m or 
inflection point ASCII data for transmission. 
Print:  Print the plot displayed. 
Exit:  Exit XBT Program.  Use this EXIT button, NOT the X in the corner to Exit. 

 

Set Up: 
XBT Instrumentation: choose the type of probe you are using. Should be “Deep 
Blue”. Make sure the recorder type is MK-21 and the Terminal depth is 1000m. 
 
System Configuration: This is where you enter the cruise name, operator name, 
choose the type of auto launcher or hand launch. Make sure that: data type is Full 
Resolution, and “Save Binary Wthout Question” is selected. You can select  or 
deselect “Automatic Transmit Binary Real-Time XBT”. Mandatory Input of Serial 
Number should be NO. 
 
Advanced system configuration: Not used for Hand Only systems. 
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Autolauncher: Not used for Hand Only systems 

 
Drop Plans: Not used for Hand Only systems 

 
 
StationData: 

Station data for upcoming trace: This lets you input position information for the 

upcoming drop. 

Station data for completed trace: Allows you to input data about the previous drop. 
Changes last.bin  File information. 

 
Launch: (buttons on main screen) 

Begin Hand Launch: For Hand launching, follow instructions in lower left XBT 
Program window, must “Stop AL Cycle” first. Launch Status will continue to update, 
and data will be acquired. 
 
Note: Below options are not used for Hand Only Systems. 
 
Begin Manual Launch: Use for Re-drops and tests, must “Stop AL Cycle” first. 
Launch Status will continue to update, and data will be acquired. 
 
End: This will terminate the current drop. Can freeze XBT Program if in AL Cycle.  

 
Transmit: 

Last Profile: Transmits last drop. 
Selected Profile: Transmits selected drop. 
Re-enable: Allows auto transmit. This should not be necessary at this time and will 
hopefully become obsolete. It used to be used if Auto Transmit Failed. 
 

Reports:   
Launch Status: Not used for Hand Only Systems. 
  
Alarms: Not used for Hand Only Systems. 
  
History Profiles: Gives you the list, in a .txt file, of successful drops including time 
and location. 
History no-splash: Gives you list, in a .txt file, of most recent drops that did not have 

water                                                                    contact. 
History Alarms: Not used for Hand Only Systems. 
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View Profile:  
These options affect the XBT display window. 

Number to display: How many profiles to display in XBT window. Can display up to 
20 profiles at a time. Default is 5. 
Clear Selected Profile: Use right mouse button to select the profile you want to clear 
from the screen. 
Clear All Profiles: Removes all profiles showing 
Graph Scale: Set whatever you want as the temperature scale, or use AutoScale. 
Zoom:   

On: If on can zoom in on graph by left clicking and dragging. Autoscale must 
be on for Zoom to work. 
Off: Turns Zoom Off. 
Out:   Pulls out of zoom. 
 

 
                                                                   Figure 6 XBT drop profiles 

 
 
Position Plan : Not used for Hand Only Systems. 

 
Help: 

About Version: Use to check that you have the correct version of XBT Program 
Help Manual: Help Topics – Useful. 
 

Utilities: 
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Display Mapped Profiles: Once this window is open go to “FILE | OPEN” and then 
pick all archived files you want to view from C:\Program 
Files\Amverseas\XBT\Archive. 
 
Start of Cruise remove old logs: Not applicable for Hand Launching operations. 
 
Create Pos Plan, Drop report from Drops:  Not applicable for Hand Launching 
operations. 
 

XBT Data Handling: 
Data Storage: 

Location of Archived XBT Files:  All the archived files can be found in 
“C:\Program Files\AMVERSEAS\XBT\Archive”. They are named according to the 
date and what drop number for that day it is. For example, the archived file name will 
look something like this: X050110N15. This drop was done on January 10 2005 and 
was the 15th drop done that day. The “N” number does not correlate to what drop 
number in the plan it is. It’s helpful to keep track of what day (GMT) you’re on for 
tracking purposes. 

 
Data Transmission: 

With Automatic Transmission:  
Files Should Be Transmitted automatically from the XBT Program.  See “XBT 
Program | System Configuration | Automatic transmit”. You can view all the files 
transmitted by going to “Transceiver Program” and Select “Utilities | View Transmit 
Log”.  
Or alternatively go to  “C:\Program 
Files\AMVERSEAS\Transceiver\Reports\XmitLog.Txt”. Once the log is greater than 
50K then the Log is moved to the 2nd XmitLog2.Txt and a new XmitLog.txt begins. 

Without Automatic Transmission:   
Transmitting multiple XBT files: 
If you are not using Auto transmit, find the files you want to transmit and copy them to 
the “C:\Program Files \ Amver Seas\ Transceiver \ Xmit directory”.  Only send copies 
– files are DELETED after transmission.  See the “Transceiver Program | Utilities | 
Check For Files To Transmit” for more instructions. 
 
Transmitting Single XBT files:   
From the XBT main menu select “Transmit | Last Profile” to transmit last drop.  Select 
“Transmit | Selected Profile” to transmit any binary file in the Archive Directory. 

Archive XBT Data: 
This is to be done at the end of a cruise. Go to Amver Seas main menu item “Utility | 
Archive XBT Data”.  After the archiving is done a dialog pops first informing that 
XBT Files in the “C:\Program Files\Amver Seas\XBT\Archive” directory  have now 
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been zipped and saved. Then another dialog pops up asking  “Do you want to delete 
Archive XBT Files?”. If you answer “OK”, files in Archive directory will be cleared 
out and deleted. Of course files have just been zipped and saved so no problem in 
deleting these files.  If you answer “Cancel” files are not deleted 

 
Trouble Shooting: 

At the First Sign of Trouble. 
Close Amver Seas. Copy the entire AMVERSEAS directory to your backup directory 
and rename it (eg AMVERSEAS_BkUp). Reboot computer. 

GPS mouse 
Windows XP has a known problem where it identifies streaming GPS data as an active 
mouse. If you ever see what looks like a satanic active mouse on a computer connected to 
a GPS (like the SIO Furunos): 

1. Turn OFF the GPS 
2. Go to Device Manager and find the extra mouse (Usually a “Serial Ball Point 

Mouse”)  
3. Disable the offending alien mouse. Make sure you do not disable your working 

mouse! 
4. Do this to every COM port that might have a Furuno plugged into it one day to 

avoid any nasty surprises. 
5. Turn on the GPS, check that you are receiving data in to the appropriate 

program or check with Hyperterminal. 
 
MK-21 USB  

 
Reboot: MK-21 USB adaptors are in no way plug and play. If ever XBT Program or 
Sippican MK-21 program can not “see” the MK-21, reboot with the MK-21 USB 
plugged in (and powered, if applicable). Sometimes you have to pull the USB out and 
reseat it while the computer is up, then reboot. If you have a power failure, you may 
need to reboot. Make sure MK21 is on while you do this. 
You see “Spent Canister” on the XBT Program display when you try to drop a probe. It 
stays in “Spent Canister” mode until the drop time out.   This is a serious error and this 
could mean that the  MK21 USB card is blown. 

Incorrect Dates/Times in Transceiver interface, Windows or XBT data 
Uninstall EasyMail. Sometimes Easy Mail changes the computer time. Check all 
computer settings to make sure you are set to the Correct UTC Date/Time and 
Casablanca, Monrovia. Timeserver sets computer date and time to UTC from GPS 
every 15 minutes?  See section III) Amver Seas Setup,  Set Up System Clock. 
 
Thrane & Thrane 
The Thrane & Thrane transceiver should be powered down for a few seconds every 
voyage. Apparently the buffer can fill. If you’ve been using “Transceiver Interface 
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Program” exclusively and start having problems, power down the transceiver for a few 
seconds then power back up.  This will not affect Amver Seas other than clearing out 
the directory of the Thrane and Thrane. 

 
Useful Iinformation: 
ScreenShots 
Screen shots are useful for diagnostics, troubleshooting, sharing information or when 
reporting a problem or unusual program behavior. 
 

1. Take a screen shot: 
Shift+Print Screen  - copies entire desktop, including bottom task bar. You 
can arrange various windows to show whatever you want. 
 
Alt+Print Screen - copies a selected window. Use this to record whats going on in 
a single window. 
 

1. Open a program that can manage images: Open Office Draw, Paint, MS Photo 
Editor, are all  good options. Both Open Office and Paint are available on all Shuttle 
computers. 

 
2. Paste screen shot: 

Shift+Insert- pastes your selection (desktop or window) into the image program. 
Or paste directly in to your report.  

 
• Save Screen Shot: 

Some programs like Paint allow you to save as .JPG, in others you need to click to 
select the screen shot and use File>Export>.JPG(Open Office Draw for instance). 
Some programs (Such as MS Photo Editor or Paint) you may need to crop the 
image. You want the resolution of the .JPG  to be adequate to see details in the 
screen shot, but not so high to make a monster file. Play around with it to find what 
suits you.  
 

• Use in reports: 
Open Office text docs use Insert>Graphics>From File>screenshot.jpg 
Save the report as an MS Word Doc format and your report will be readable by a 
wide range of programs.  But label each imbedded screenshot in your text doc with 
the screen shot name and include those .JPEGs in a separate folder as backup. 
 

• Save as a .PDF document (optional): 
Open Office allows any document, spreadsheet, drawing or presentation to be 
exported as a .PDF file (File>Export as PDF). This can be very useful if you want to 
make an uneditable report that can be read by anyone who has Adobe Acrobat 
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Reader. Its also useful for reports with imbedded images where the images or 
formatting may shift depending on software and settings over various computers. 
However - only a computer with Acrobat Professional installed can edit that 
document or copy text and images out of it.   
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Thrane & Thrane 3026 Mini-C transceiver setup 
All of the circuitry is now in the head/egg/antennae of the unit, replacing the blue box of 
the TT3022’s. You wire the many wires of the "antennae" cable into a small connector 
box (pictured).  DO NOT just wire color to color. That is only IF you have remote on/off 
(we don’t).  
 
You must put BOTH the yellow and orange wires into the orange slot. This is very briefly 
described in section 2.2.2 of the manual. 

 
This image shows: 
1) the correct wiring,  
2) the location of the W2 
jumper (should be in the 
correct place when you 
get a unit), and  
3) the 2 lights on the 
front that should light up 
when you put power to 
the box.  
 
Hint for wiring: use 
tweezers and the smallest 

screwdriver you have. You may want to tin the ends. 
 
Plugging into a WinXP computer: 
Windows XP may see the serial connection and streaming data from a T&T MiniC as a 
Serial Ballpoint Mouse. We have seen this before with the Furuno GPS's.  
 
If you connect the MiniC  to your computer and 1) your computer auto recognizes a new 
device and identifies it as serial ball mouse, and/or 2) your mouse starts jumping around 
the screen: 
 

-Turn OFF the power to the Mini-C terminal block (just unplug it) 
- Go to device manager (right mouse click on My Computer >Properties > 
Hardware > Device Manager) 
-Click on mice and other pointing devices 
-Right mouse click on the Serial Ball Mouse and select DISABLE 
-Exit device manager 
-Reboot. 
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EasyMail: 
Testing, setup & sending messages via EasyMail: 
 
Software: 

• Thrane & Thrane EasyMail v1.10. Available for download at 
http://www.tt.dk/Land%20Mobile/Products/easyTrack/easyMail.aspx or the NOAA 
SEAS FTP site.   

• NOTE: if you install over an earlier version of EasyMail (or even if you have 
uninstalled previous versions), it will keep your addresses but will update your ISP 
list – this update is necessary! 

 
Installation: 

1. Double click on the setup icon. 
2. Follow instructions, click next to continue, accept the licensing agreement. 
3. Set for “Anyone who uses this computer (all users)” unless you want this 

available  only to the current logged in user. 
4. Click install, then finish. 

 
Settings (with the Transceiver powered up and connected to the computer): 

1. Turn OFF SEAS Transceiver Interface, and anything else that might be using the 
COM port and Thrane & Thrane. 

1. Start EasyMail either from the desktop shortcut or from Start>Programs>Thrane & 
Thrane>EasyMail>EasyMail 1.10 

2. Accept Warranty disclaimer. 
3. First message asks if you want to “Adjust the time of the PC to the local GPS time” 

CLICK on “Save settings and don’t show this message again” and click NO. This is 
important or you can mess up the XBT drop time! 

4. IF you are NOT using COM1, go to OPTIONS>CONFIGURATION>COM 
settings and select the COM port you wish to use. Keep at default baud rate 4800. If 
you are using COM1, you do not need to change anything. 

5. Go to OPTIONS>CONFIGURATION>ROUTING and select to 1) send mail to 
disk & 2) local printer setting to OFF. Do this quickly or the program may shut 
down with an error in its attempt to find a printer. Make sure nothing is going to 
printer, just to disk. Click or unclick the rest of the EGC messages as you wish – the 
safety messages can’t be de-selected. 

6. Go to OPTIONS> Set Default LES to these values: 
• W. Atl : 001 Southbury  
• E. Atl : 101 Southbury  
• Pac. : 201 Santa Paula  
• Ind. : 304 EIK 

7. Go to OPTIONS>Set Default ISP to “Telenor01” in the dropdown box. According 
to Telenor we can also use Telenor04. Don’t change any of the default settings. 
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8. Go to CONTACTS and add new addresses: 
i. Click New Entry 

ii. Enter name 
iii. Enter email address 
iv. Select Email 
v. Select 7-bit 

vi. Click OK 
 
To send an email: 

2. Turn OFF SEAS ‘Transceiver Interface” and “TimeServer” programs or anything 
else that might be using the COM port and Thrane & Thrane. 

3. Click on the TO… and select the email addresses you wish to send to, cc or bcc, 
click OK.  NOTE – use this function rather than manually entering email addresses 
in the TO… line. 

4. Enter a subject 
5. Type your message, keep it short! 
6. When ready to send, click Send -  in the settings box for sending: 

i. Keep Text in Editor checked 
ii. REMOVE Confirmation Request (unless you are having 

problems/trouble shooting) 
iii. Keep send later and print option deselected. 
iv. Click OK 

7. Click on OUTBOX, and wait for status = delivered for your message. 
 
To check email: 

1. Click on INBOX. 
2. Double click on new message. Note that you have the option to save or reply from 

here (but if you reply, delete excess text to keep costs down. 
 
When finished with email: 

1. Exit EasyMail 
2. Turn ON Transceiver Interface &/or TimeServer or whatever wants to use that 

COM port and the Thrane unit. 
 
Trouble shooting: 

1. EasyMail has many message windows for errors – read and follow instructions if 
they pop up. 

2. On the left side of the main window you should have 3 green bars for GPS, Ant. 
Signal and PC connection. If you click on the Ant. Signal it will show hardware 
status. Under the Rx/TX/AGC you want the 2nd value (TX = transmission) to be 
over 1,000. If its not, check your antennae and connections. 
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3. In certain parts of the ocean you may wish to change LES if you are having 
problems sending or receiving. For instance AOR-W works better than POR in the 
northern and southern areas of the eastern Pacific. 

 
Other Programs: 
Sippican WinMK-21: very handy for checking the MK-21 USB if you are having 
problems. Try Activate to get the MK21 clicks. All MK-21 USB drivers are in 
Programs>Sippican>MK-21USB>Win-XP if Windows asks or you are doing a fresh 
installation. INSTALL  BEFORE AMVER SEAS on a fresh install.  
Acrobat Reader: Helpful to read many electronic technical manuals. 
AntiVirus Software:  Apply updates when you meet the ship. 
BurnIn Test: Hardware test software. Need USB and Serial Test plugs to test USB and 
Serial ports. But you can check hard drive, video driver, floppy (need blank disk) 
and CD (need data CD). 
Hyperterminal: Start>Programs>Accessories>Communications>Hyperterminal.  Use 
to check is Windows is “seeing” data coming in through a COM port. Works for 
GPS NMEA data or AutoImet data.  Settings should be 4800, 8 N 1, no handshaking. 
 
Open Office:  Similar to MS office, but Open Source. Can create documents, 
spreadsheets, drawings and spread sheets. Handy ability to export docs as .PDF files. 
Save documents as something universal (.txt, .jpg, .xls, .rtf etc, NOT in Open Office 
native format). This allows everyone else to open and read/edit your stuff. 
 
Shuttle Build and Installation Checklist 
This checklist is what Carrie Wolfe uses to build a Shuttle computer. Everything 
needed to do this is included in the box the computer came in (of course you wont be 
able to get the latest Windows updates at sea). Info below is included in computer 
boxes too. 

Tasks: SSID 

General 
Install/update drivers                                                       + 
Acrobat Reader 

 Updates incl XPSP2 
 Set time to Casablanca Monrovia GMT 
 Check HD, CD, FDD 
 Install serial 3 & 4 drivers -Optional 
 Install Open Office 
 Set to numlock on boot 
 Set SEAS user as admin & only user - boot to desktop 
 Run BurnInTest 15 minutes 
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GPS NMEA 0183 Windows 
issue 

Boot w/ Furuno GPS plugged into comm port. Allow to 
recognize, then disable "serial ball mouse" for  COMs 1-
4. (Windows Key + Break brings up “Device Manager”, 
or START>Settings>Control 
Panel>System>Hardware[tab]>Device Manager).   In 
Dev Manager “Mice and other pointing devices” Right 
click on “serial ball” and disable.   DO ALL 4 COMM 
PORTS! 

COM Ports 

Test COM 1-4 w NMEA in hyperterminal 4800 8N1 
None  
(START>Programs>Accessories>Communications>Hyp
erterminal) 

Sippican Install Sippican Data Acquisition Software 

**see below 

Plug in MK-21 USB - let windows XP recognize and  
find ARSUSB1.dll and ISAUSB.sys from HDD (not 
CD). 

 Initiate MK-21 board (click) 
AMVERSEAS Install latest AMVERSEAS200 w/ AutoIMET 

admin=TEST 
Set & check Transceiver Interface Program to COM1. 
Set to SEAS xmit 

 Enable XBT 

 
configure XBT for Deep Blue, auto xmit, save w/out 
question 

 Check XBT HL w/test canister in all USB ports 

 
Check AutoImet COM2, hourly   (AutoImet 9600 8N1 I 
think LL) 

 Send test XBT & Met message 
 Put AMVERSEAS.exe in start menu 
CapSat Create folder C:\Temp 
 Install CapSat V3.03 to C:\CapSat 
 set to no printers in routing and COM 1 
  

 
**Sippican drivers etc. Install from CD: 

1) Install WinMK21 from Sippican Surface MK-21>SETUP>WinMK21 
(ftp.aoml.noaa.gov/phod/pub/seas/) 

2)Plug in MK21 USB, and get "found new hardware" msg. Pull out CD here. Let 
WinXP search for drivers. Install from Location  

C:\program files\Sippican\MK21USB\WInXP It should find ARS Tech USB Device, 
arusb1.dll & isausb.sys and install drivers automatically. 

3) REBOOT with USB plugged in. For some reason, the MK-21 cant initiate unless the 
machine shuts down and starts with the USB plugged in. 
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4) Check MK-21 USB via Sippican\WinMK21 > Actions > Initiate MK IO board. Hear 
the "click of love". 

5) plug MK-12 USB cable in to all 4 USB ports following steps 2-4 above. 
From then on AMVER SEAS XBT will work just fine. Only need to restart if the USB 

plug is removed and plugged in again. 
 
READ ME FIRST      
 

1) This computer has been tested with all of the items and components on the attached 
list. Please read these notes on the care and feeding of these computers. 
2) This computer was working when it left me.  But it WILL NOT RECOGNIZE THE 
USB MK-21 UNLESS YOU REBOOT WITH THE USB PLUGGED IN. So if you 
plug the USB in with every thing shut down, and the MK-21 is not recognized in 
SEAS2000, reboot. 
3) All of the system software used on this computer is being shipped with this 
computer. Store this software in a safe place (not on board the ship).   Windows XP pro 
is licensed to each individual computer, the key is on the computer case, and these are 
single licenses. AMVERSEAS2000 Sippican MK-21 , and a whole lot of other stuff is 
on the SEAS2000 etc disk. Other useful stuff like Open Office is included on the Open 
CD. 
4) Right now these computers have no virus protection. I recommend going to    
http://www.free-av.com/index.htm  and down-loading software &  updates to install 
every time you visit the ship. 
5) All of these computers have Open Office software involved that can open, create 
and save any type of MS Office-type files (documents, spreadsheets, drawings and 
presentations). 
6) I do not think that we want bridge personnel installing software on these machines, 
and we are looking at security options that will disallow this. Right now the SEAS 
login has administrative rights with no password. 
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Appendix 1 -Quality Control Codes 
 
The complete list of quality control codes is defined in Bailey et al., 1994.  

The following are those most commonly used. 
 
Profile Rejected - R Codes 
 

RER - Bad Redrop 
WBR - Wire Break 
WSR - Wire Stretch 
IPR - Insulation Penetration 
LER - Leakage 
CTR -  Constant Temperature 
OPR - Other / Probe Error 
HFR - High Frequency Interference 
 

Profile Accepted - A Codes 
 

REA - Redrop 
DUA - Duplicate Drop 
WSA - Wire Stretch 
IPA - Insulation Penetration 
HBA - Hit Bottom 
SAA - Surface Anomaly 
PIA - Probable Inversion 
IVA - Inversion Confirmed 
NUA - Nub 
TDA - Temperature Difference 
PSA -Possible Fine Structure 
STA - Step-like Fine Structure 
EFA -  Eddy Front
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Appendix 2 - Connector Box and System Grounding 
 
The launcher is connected to the MK21 card through the Connector Box. This is 

also where the system ground is connected to seawater ground. This connection is made 
from the lug on the outside of the connector box to some metal part on the ship's hull 
(rudder post, plumbing pipe, lug to the metal hull). The seawater ground should be as 
electrically clean and pure as possible. This connection should make excellent metal-to-
metal contact with a 12 awg minimum wire or braided cable, and be protected from 
corrosion and vibration. It should measure less than 100 ohms (from connector box lug 
to seawater). There should be only one ground in the system to avoid ground loops. For 
hand-held launchers, the internal connector box wiring should look like the drawing 
below.  

  
The grounding approach for the hand-held launcher differs from the approach for 
the deck-mounted and thru-hull launchers.  For the hand-held launcher the ground 
is made at the connector box, while for the others it is usually right at the 
launcher.  In either case only a single ground point should exist on the launcher 
and its cabling to the PC. 
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Appendix 3 - XBT - Principle of Operation 
 

The circuit diagram of the XBT probe is shown in Figure A3-1.  Supplying a 
constant current (about 30 x 10-6 A) through both the thermistor and resistor to ground 
allows V1 and V2 to be measured with respect to ground (point D in Figure 12).  Using V 
= I . R: 
V1 = I . (R thermistor + R wire + R water), and  
V2 = I . (104 Ω + R wire + R water). 
 
The difference, V2 - V1 = I . (104 Ω - R thermistor), yields R thermistor  and hence the 
ocean's temperature, given the calibration curve of the thermistor.  Resistance of 
thermistors vary inversely with temperature. 

Depth is simply inferred from time.  The probe lightens as its wire unspools, so 
depth is calculated from a second degree polynomial (Sippican, 1994) to include 
acceleration: 

 
z  (meters) = 6.472 t - 0.00216 t2 (t in seconds). 
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Figure A3-1. Circuit diagram of the XBT probe. 
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